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S5 EDITORIAL

This magazine was created using :

WELCOME TO ANOTHER ISSUE OF FuLL CIRCLE. J4 -l | oo
-
B oth Greg and Elmer return this month (for Python and LibreOffice respectively) and are " ‘
joined by John who returns with another LaTeX article. The fourth article isn't really a

HowTo, but | wanted to include it anyway so that you programmers out there can have some
fun throughout December. It's an article on advent programming. In other words; a daily
challenge from the first of December through to the 24th (Christmas Day).

LibreOffice

The Document Foundation

co)Ereative
commons

This month Charles touches upon 3D printers. This is something | plan on covering from
next month onwards as I've just taken delivery of a RepRapPro Fisher 1. This printer was

previously sold in 'beta’, but now it's in v1.0 and I'll be discussing the build and software in . . '

the coming months. Find Full Circle on:
As | write this the latest Ubuntu phone update (OTA-8) is being rolled out. This is the last W g00.gl/FRTMI

update of 2015. The next one, OTA-9, will be due for delivery near the end of January. And N\

all you Russian readers will be happy to hear that the BQ E5 is now available to buy in Russia

and comes with special Russian scopes pre-installed. Enjoy! facebook.com/fullcircle

magazine

| also have a couple of books here that | need to plough through to get reviews written
up. One is '"How Software Works', and the other is 'The Maker's Guide to the Zombie E twitter.com/#!/fullcirclemag
Apocalypse'. Oh, and | also have another book review for next month too.

http://issuu.com/Ffullcircle
magazine

All the best, and keep in touch!

et E E ©
ronnie@Fullcirclemagazine.org = - > https://play.google.com

/store/books/author?id=
Ronnie+Tucker

http://www.magzter.com/
publishers/Full-Circle

[=]
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NEWS

SNAPPY UBUNTU 16.04 LTS :
WiLL SuPPORT NVIDIA AND
AMD DRIVERS, SAYS MARK
SHUTTLEWORTH

R emember when we told you,
guys, that Mark Shuttleworth, :
founder of Canonical and Ubuntu
Linux, the world's most popular
free operating system, said that
Snappy Ubuntu Core 16.04 LTS
would support private snaps?

Well, today we have more
excellent news for all of you who
use the Snappy Ubuntu Core
operating system on embedded
and loT devices. Mr. Shuttleworth
has stated in a recent email on the :
Snappy Core mailing list that the
upcoming Ubuntu Snappy Core
16.04 LTS (Xenial Xerus) operating
system will support proprietary
graphics drivers.

Submitted by Arnfried Walbrecht

Mark Shuttleworth immediately

. replied that they would all be
: supported in the 16.04 LTS release

of the operating system.

Source:

http://linux.softpedia.com/blog/sn
: appy-ubuntu-16-04-lts-will-

: support-nvidia-and-amd-drivers-
: says-mark-shuttleworth-
: 495462.shtml

. IBM TAKES LINUX
. MAINFRAMES BACK TO THE
. FUTURE

: I BM introduced several

significant new elements for its

© Linux server stack last month:
. support for KVM on its z Systems
: mainframes, Linux-only models in
. both the z Systems and Power

: Systems ranges, and a new

When asked by Dan Kegel if
Snappy Ubuntu Core has support
for high-performance OpenGL
graphics drivers, such as the
proprietary ones from Nvidia and
AMD, as well as those from Intel,

. purchasing model.

: The most technically interesting
. new development is mainframe :
: support for KVM, the Linux kernel's :

built-in hypervisor. Although this is

© just a new way to access facilities
© that existing IBM products offer, it :
. may help drive migration of x86
. workloads onto IBM’s highest-end
: kit.

Big Blue's big iron already has

. rich virtualisation offerings. At the
. lowest level, the PR/SM facility

. splits each machine’s resources

. into multiple logical partitions

. (LPARs), each appearing as a

: separate machine with a portion of :
. the host’s processing and storage
. capacity. Even if the machine’s

. configured as a single unit, it's

. really one LPAR.

Source:

http://www.theregister.co.uk/2015
: [11/02/ibm linux_mainframes/

How WILL THE BiGc DATA

. CRAZE PLAY OUT?

hat happened in 2011? Did
Big Data spontaneously

some kind? A coordinated set of
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: campaigns?

Though I can't prove it (at least

. notin the time | have), | believe the
© main cause was "Big data: The next
© frontier for innovation,

. competition, and productivity",

. published by McKinsey in May

: 2011, to much fanfare. That report,
. and following ones by McKinsey,

. drove publicity in Forbes, The

: Economist, various O'Reilly pubs,

Financial Times and many

. others—while providing ample

. sales fodder for every big vendor
. selling Big Data products and

© services.

Among those big vendors, none
did a better job of leveraging and

. generating buzz than IBM. See

: Resources for the results of a

. Google search for IBM + "Big

: Data", for the calendar years

: 2010-2011. Note that the first

. publication listed in that search,

: "Bringing big data to the

. Enterprise”, is dated May 16, 2011,
. the same month as the McKinsey

. report. The next, "IBM Big Data -

: combust? Was there a campaign of | \where do | start?" is dated

November 23, 2011.

n contents ©
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Source:
http://www.linuxjournal.com/cont

Source:

. http://www.wsj.com/articles/micro .

ent/how-will-big-data-craze-play-

. soft-and-red-hat-reach-linux-deal-

out

MICROSOFT AND RED HAT
ReEACH LINUX DEAL

M icrosoft Corp. and Red Hat
Inc., longtime rivals from

conflicting camps of the software
cloud.

The companies are announcing
a partnership Wednesday to make
Red Hat's version of the Linux
operating system available to
users of Microsoft Azure, the
software company'’s cloud service.

Under the deal, Microsoft
agreed to designate Red Hat's
Linux as its “preferred” option for

Azure. In addition, personnel from
in Redmond, Wash.—Microsoft’s
hometown—to offer technical

support to customers.

No financial elements of the
deal are being disclosed.

: 1446642000

OMNIRAT LeTts HACKERS 5
. CONTROL ANDROID PHONES, :

: WINDOWS. MAC. AND LINUX - malicious campaigns in action, one
: ’ ’ .

. PCs

industry, plan to collaborate in the RAT stands for Remote Access

Trojan (some use the term

. Tool as well) and refers to a

: particular piece of malware that

. infects user computers via a client
. component, which then starts

. communicating with a server

: counterpart. This allows an

. attacker to steal data from a

© target, spy on the user, and even

. take control of the victim's device.

Unlike previous Android RAT

enterprise-style computing jobs on kits, OmniRAT comes with built-in
. support for controlling desktops,
both companies will work together i something that its competitors

. don't have the ability to do.

- Additionally, also compared to its

. competition, OmniRAT is also ten

. times cheaper to purchase, being

. offered for sale at prices between

© $25 and $50 (€23 and €46).

Software like this is not illegal,
mainly because it is also used by

- programmers and testers in their
. daily jobs. RATs become illegal

. when someone uses them for

- malicious purposes.

Around mid-August this year,
Avast detected one of these

. thatinvolved a version of
: OmNIRAT, spreading via SMS
messages.

Source:

 http://news.softpedia.com/news/o :

weaknesses that could be fixed but
haven't been. Worse, as Internet

. security has surged as a subject of

: international concern, Torvalds has
. engaged in an occasionally profane
© standoff with experts on the

: subject. One group he has

. dismissed as “masturbating

. monkeys.” In blasting the security

. features produced by another

. group, he said in a public post,

. “Please just kill yourself now. The

. world would be a better place.”

Source:
http://www.washingtonpost.com/s

. mnirat-lets-hackers-control- :
: android-phones-windows-mac-and- :

. f/business/2015/11/05/net-of-

insecurity-the-kernel-of-the-

: linux-pcs-495779.shtml

. THE KERNEL OF THE
. ARGUMENT

that Torvalds created and

. named after himself, has come to
. dominate the exploding online

. world, making it more popular

. overall than rivals from Microsoft
- and Apple.

But while Linux is fast, flexible

- and free, a growing chorus of

critics warn that it has security
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. arqument/

. MENTOR GRAPHICS

. ANNOUNCES CUSTOMIZABLE,
i , , . SECURE END-TO-END lOT

; or Linux, the operating system :

e F . SOLUTION WITH INTEGRATED
. GATEWAY, CLouD AND EDGE

DEVICES

M entor Graphics Corporation

announced the availability of

its customizable edge-to-cloud loT
solution that enables companies to
- getits product to market quicker

h contents ©
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while helping to reduce risk, cost,
and development cycles. The
Mentor IoT solution comprises a
unique customizable loT gateway
System Design Kit (SysDK), a cloud
backend, and runtime solutions on

which to build an array of 10T edge
. the ongoing Trans-Pacific
Partnership (TPP) negotiations, the :
. multinational trade agreement

devices. It enables loT

requirements with support from 8- :

bit microcontrollers to 64-bit

microprocessors, and deployments :
. series of secret negotiations and
. aims to create a host of new

: restrictions. We here at the FSF :
. have been fighting against TPP for :
. years, as it represents the threat of :
- a world dominated by DRM,

- software patents, and perpetual
. copyright.

of 100,000+ gateways each
supporting dozens of edge
devices.

To provide customers Flexibility
in meeting business needs, the
technology can be licensed
commercially as an end-to-end
solution orin parts to address and
complete a customer's existing
solution. Additionally, Mentor
Graphics can deploy and manage
the solution as a service to
customers. Both options are
available today.

Source:

http://www.arcweb.com/Blog/Post :
. these corporations oppose. For

. example, Big Tobacco has used the
: system to block or obstruct health
. laws intended to reduce smoking

: in countries around the world.

/859/Mentor-Graphics-Announces-
Customizable,-Secure-End-to-End-
loT-Solution-with-Integrated-

Gateway,-Cloud-and-Edge-Devices

LATEST TPP LEAK SHOWS

: SYSTEMIC THREAT TO
SOFTWARE FREEDOM

released a leaked chapter of

that is being developed through a

The latest leaked chapter on

- investments lays out changes to a
. system of supra-national courts

- known extrajudicial investor-state
. dispute settlement (ISDS)

- tribunals. For years, these courts

. have enabled large companies to

- sue democratically-elected

governments over policies that

While all of this is bad news in

general, one provision in the
leaked document presents a

: particular threat to software

. freedom. Holders of copyright,
: . patent, and other proprietary
O n March 25th, 2015, Wikileaks :

- definition of "investor." Given the
. destructive nature of these

interests are now included in the

provisions, the fact that

. proprietary developers could use
: them to interfere with local

. government protections of users'
© rights is cause for alarm.

Source:

. NEW ENCRYPTION
. RANSOMWARE TARGETS
. LINUX SYSTEMS

about $500).
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Many of the systems that have

. been affected by the malware

. were infected when attackers

. exploited a vulnerability in the

: Magento CMS. A critical

. vulnerability patch for Magneto,
. which is used to power a number
. of e-commerce sites, was

. published on October 31. Doctor
. Web researchers currently place
. the number of victims in the "at

. least tens" range, but attacks on
. other vulnerable content

© management systems could

- increase the number of victims
https://www.fsf.org/blogs/licensin :

: g/latest-tpp-leak-shows-systemic-
. threat-to-software-freedom

. dramatically.

In order to run, the malware has

© to be executed with administrator-
. level privileges. Using 128-bit AES
. crypto, the malware encrypts the

. contents of all users' home

. directories and any files associated
. with websites running on the

. systems. It then goes through the
he antivirus software company : \hole directory structure of
: Doctor Web has issued an alert :
. about a new form of crypto-

. ransomware that targets users of
. Linux-based operating systems.

. Designated as "Linux.Encoder.1" by :
. the company, the malware largely
. targets Web servers, encrypting

. their contents and demanding a

- ransom of one Bitcoin (currently

: mounted volumes, encrypting a

. variety of file types. In each

. directory it encrypts, it drops a

. text file called

: README_FOR_DECRYPT.txt. This
. demands payment and provides a
. link to a Tor "hidden service" site
: via a Tor gateway.

h contents ©
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Source:
http://arstechnica.com/security/20
15/11/new-encryption-
ransomware-targets-linux-
systems/

LiNux FOUNDATION
LAUNCHES OPEN SOURCE
HiGH-PERFORMANCE
CompuTING GROUP

he Linux Foundation, a

nonprofit organization that
promotes the Linux kernel and
other open source projects, has

partnered with Dell, HP Enterprise, .
Intel, Fujitsu Systems Europe and a : SMALLER THAN A CREDIT
. CARD': TINY

. SUPERCOMPUTER COULD

MEAN SELF-FLYING DRONES
Producing a stable environment

number of university research labs
to create the OpenHPC project.
The collaboration will center on
four main goals:

for testing HPC software

Creating an open source
framework for HPC environments
that will reduce costs

software stack suited to a variety
of applications

Building a configuration
framework that offers developers
and users flexibility to tailor HPC
software to meet their needs.

The time is right for new
investment in open source HPC

. software because such software is
- vitalin fields like meteorology,

. astronomy, engineering and

. nuclear physics, yet it has not been :
. developed in a central, efficient
- way, according to the Linux

: Foundation.

Source:

. http://thevarguy.com/open-
: source-application-software-
: companies/linux-foundation-
: launches-open-source-high-
: performance-co

ith NVIDIA's new machine

As a result, the platformis
capable of performing complex

tasks such as recognizing images,
processing conversational speech,

. oranalyzing a room full of
furniture and finding a path to
; nr?wgate across' it. NV;—:Z!Ia t:llescrlped percent of the patch being drivers,
the Jetson TX1's machine learning - and 10 percent being architecture
. updates," said Torvalds in a release

: statement.

. abilities as "a groundbreaking
. technology that will give

: autonomous devices a giant leap in :
© capability". :

NVIDIA would like us to think

that its newly announced Jetson
- TX1isa few sort of Al upgrade qu . core infrastructure.”
. computers and networks, one built :

. to aid autonomous systems by :

- enabling machine learning.

Source:

http://heraldvoice.com/2015/11/1
: 5/smaller-than-a-credit-card-tiny-
supercomputer-could-mean/

LiINUX 4.4 GLIMPSES THE

: learning module, companies : FUTURE WITH ITS FIRST
- will be able to specifically identify :

X o - construction vehicles, building
Developing a sophisticated HPC  ratarials and other structures, so
. they'll have even more relevant

. information to manage their job

. sites using commercial drones".

. RELEASE CANDIDATE

INUX IS already past the point

candidate for kernel version 4.4.
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"Just looking at the patch itselF,

. things look fairly normal at a high
. level, possibly a bit more driver-
. heavy than usual with about 75

"The remaining 15 percent is

documentation, filesystem, core
. networking (as opposed to
. network drivers), tooling and some

He also explained that driver

changes for staging, networking
- and GPU drivers account for 40
. percent of the entire kernel patch.

Around half of the content is

aimed at ARM-based architecture,
while x86 and others make up the
other half.

The change list is, as ever,

phenomenal in size, but includes a
. number of improvements for loT
: support for ARM processors and

_ : updates for DRM.
when, in theory, Skynet should

. have created a T-800 Terminator to :
. save John Connor, and Linux '
puppetmaster Linus Torvalds has
- released the first release

There are likely to be up to 10

release candidates before the real
deal is released sometime next
" year.

h contents ©


http://arstechnica.com/security/2015/11/new-encryption-ransomware-targets-linux-systems/
http://thevarguy.com/open-source-application-software-companies/linux-foundation-launches-open-source-high-performance-co
http://heraldvoice.com/2015/11/15/smaller-than-a-credit-card-tiny-supercomputer-could-mean/

NEWS

Source:
http://www.theinquirer.net/inquir
er/news/2434899/linux-44-
glimpses-the-future-with-its-first-
release-candidate

FREESCALE MAKES
SIGNIFICANT INVESTMENT IN
ReAL TIME LINUX

F reescale has just announced
they are joining the Real Time
Linux (RTL) Collaborative Project
as a Gold Member. Freescale joins
Google, National Instruments,
OSADL, and Tl with a significant

investment because they value the

strategic importance of this open
source project and the benefits it
creates for their customers.

Linux adoption for embedded
applications is Following a similar
path to what we saw in mobile,

where smartphones and their apps
P PP . has raised a new round of $15.5

. million from a broad range of
European investors as the company
. seeks to expand its cloud-based :
services beyond Windows.

drove new experiences and even
further commercial success of
Linux (via Android) in the
marketplace. In the case of
embedded systems, advances in
artificial intelligence, image and
voice recognition are sparking
massive innovations based on the

power, flexibility and cost
advantages of embedded Linux

. systems. For example, in drones

: and cars we are seeing a

. convergence of advanced image

: recognition and artificial

- intelligence giving way to pilotless
- and driverless navigation. From

: robotics, to drones, to cars, a real

: time Linux kernel is key to the

. foundation of these soon-to-be

. commercially available solutions.

Source:

. NUMECENT RAISES $15.5M
. TO BRING CLOUDPAGING TO
. ANDROID AND LINUX

I rvine, California-based software

with the rest from “European

industrialists, Family offices and
private equity firms,” according to

: Numecent. Deutsche Telekom also
led the company’s series A round.

“Numecent is on a good

© trajectory and is receiving traction
. from major players in the

- industry,” Vicente Vento, chairman
. of the supervisory board of

. Deutsche Telekom Strategic

. Investments in a statement. “This
© traction validates the view that

_ . cloudpaging is potentially

. http://www.linux.com/news/featur :
. ed-blogs/204-mike-woster/867455- :
. freescale-joins-real-time-linux- :
. project-as-gold-member

transformative not only for IT, but
also for emerging sectors like loT.”

Source:

. TEXAS INSTRUMENTS = KIT
company Numecent said today it ENABLES FAST AND EASY
. LINUX SOFTWARE AND

. HARDWARE DEVELOPMENT

he OMAP-L138 DSP+ARM9
development kit, from Texas

) ) . Instruments (TI) is designed to
The series B round includes $4.5 :

: . enable fast and easy Linux
" million from Deutsche Telekom, : ’

software and hardware
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development.

The scalable platform can ease

: and accelerate software and

. hardware development of

. everyday applications that require
. real-time signal processing and

. control functional, including

industrial control, medical

. diagnostics and communications.

The low-cost kit, complete with

. freely downloadable and

. duplicable board schematics and

. design files, greatly reduces design
. work. A wide variety of standard

. interfaces for connectivity and

: : storage allow developers to easily
. http://venturebeat.com/2015/11/1 :

: 7/numecent-raises-15-5m-to-bring- :
: cloudpaging-to-android-and-linux/
: . expansion headers and Leopard
. Imaging’s camera sensor allow

. users to extend the board’s

. functionality.

bring audio, video and other
signals onto the board. Expansion
headers such as LCD screen

The TMDSLCDK138 replaces the

. TMDXLCDK138 with the same

. performance, price and features. It
. available on a limited quantity

. basis as inventory ramps, says the

. company.

The LCDK does not have an

onboard emulator. An external

emulator from Tl (such as the

h contents ©
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XDS100, XDS200, XDS510,
XDS560) or a third-party will be
required to start development.

Source:
http://www.electropages.com/201
5/11/texas-instruments-kit-
enables-fast-easy-linux-software-
hardware-development/

LiNux DEBUGGING COMES
TO VISUAL STUDIO

M icrosoft has released a
preview of its new Visual
Studio GDB extension,
contributing to their ongoing
effort to make Visual Studio
support as many development
environments as possible.
Microsoft's Marc Goodner has

which can be used with Visual
higher.

Once installed, this extension
provides a new Project target
under Visual C++ ->Cross Platform

called “Makefile Project (GDB)".

needed on your local/host
Windows machine to enable

communication. As Goodner
explains, certificates have to be

. generated to enable secure

: communication but do note that
. pass phrases cannot be used at this :
: time so it probably makes sense to
. generate a separate certificate just :
. for this purpose. You will also
. want to make your first connection :
: using your SSH client outside of

: Visual Studio so the certificate can
. accepted. Subsequent connections :
. can then be made within Visual
. Studio.

Source:

http://www.inFoq.com/news/ZO‘I5/E
. 11/vs-qdb

. PARROT'S BEBOP 2:
. SMALLER, FASTER, LONGER-

) , ) . LASTING, LINUX-FORTIFIED
provided details of this new ability, :

. . " n San Francisco, Parrot unveiled a
Studio 2015 Community edition or : :

smaller, faster, longer lasting

: version of its Linux-based Bebop
. drone, helping to solidify its

. dominance in the mid-range

. consumer market. One of the key
. new features is an emergency

: : . cutoff that instantly kills the
Once created, an SSH client will be . quadrotor motors when a blade

" hits an obstacle. The increasing

focus on safety was also

demonstrated this week when 3DR
(Solo) and DJI (Phantom)

- announced similar new technology :
. to make it easier for their :

customers to avoid restricted

. airspace . France-based Parrot was

an early leader in consumer

. unmanned aerial vehicles (UAVs)

with its AR.Drone quadrotors,

. which bridged the gap between
: the toy and prosumer/commercial

markets. Parrot also owns a big

: chunk of the toy drone and robot

. market with products like the

: Rolling Spider and Jumping Sumo,
- as well as a newer line of Jumping,
. is typically based on the MIPS

. architecture (such as the Atheros

: AR9331) and powerful enough to
. support application languages

. such as C/C++, Python and Java.

: The microprocessor can also

. support multiple communication

. protocols (Wi-Fi, TCP/IP, HTTP etc)
. and web-based services (Chat, e-

. mail, Twitter, AllJoyn etc).

Airborne, and Hydrofoil mini-

drones, selling from $145 to $220.

Source:

http://linuxgizmos.com/parrots-
. bebop-2-smaller-faster-longer-
. lasting-linux-fortified/

ARDUINO MEETS LINUX:

. ARDUINO INTRODUCES ITs
. 3RD GENERATION
. PLATFORM

he Arduino platform's
simplicity, open architecture

and ease of use helped make it the
most popular embedded '
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development tool within the
Maker community.

Now, a third generation of

. Arduino boards is emerging that

. contains two processors. 3rd-gen

. boards such as the Arduino Yun

. have an embedded microcontroller
: (MCU) and a more powerful

. microprocessor Unit (MPU), similar
. to those found in PCs and mobile

: devices. The MCU (typically an

. Atmel ATmega32x device)

. supports the real-world 1/0

. functionality traditionally handled

by the Arduino platform. The MPU

Source:http://electronics360.gl

obalspec.com/article/5995/arduino
-meets-linux-arduino-introduces-
. its-3rd-generation-platform
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Last month, | wrote about
Ubuntu Phone, intending to
follow up on it this month.
Unfortunately, I've lacked the time
to complete the article fFor this
issue —you can expect it to be in
next month's issue. Instead, I'll
discuss a new website creation
tool called ‘static site generation'.
If you're not interested in
websites, and want to learn more
about Ubuntu Phone
programming, check back next
month!

WHAT IS STATIC SITE
GENERATION?

Static site generators are
command-line tools that can take
content from formats such as
markdown and reStructuredText,
and insert the content into HTML
templates. At the most basic, you
can think of it as a content
management system that, when
compiled, doesn’t save content to
a database, but straight into a
static html page.

¥ N COMMAND & CONQUER

Written by Lucas Westermann

. BUT... WHY?

. Anyone who has had to work to
optimize a page for performance

. knows that static sites load much

. faster (and with less effort),

. because there is no delay while
querying the database, or while

. running for-loops to insert
information. Naturally, some sites
. lend themselves to content
management systems (really large
. sites, sites with various editors and :
moderators, or sites that need to
. serve dynamic content). As is
always the case in web design, it's
. a matter of picking the right tool
for the job, in order to create the
. site as fast as possible, to have it

. perform well, and to avoid

: reinventing the wheel at every

- turn.

. But MY CMS SITE LOADS
: QUICKLY?

It's possible to have a site load

. very quickly when being used with
. a CMS, but this is generally the

- result of a great deal of testing,
and plenty of performance tweaks.

Static Site  Generation

. A COMPARISON

Note: According to studies by

: Google, any site that takes longer
: than 1 second to load (on mobile,
- mainly) will generally have users

. leave due to the wait. Studies from :
. Amazon and Google also saw that
. an increase of loading time of 1

- second (say, for example, from

: 400ms to 1.4s) could result in a

- drop of revenue between 14 and

. 18%.

A site | am working on was

. originally created using Django
. CMS - where it would load in about : {TmL, or reStructuredText), and
: 612ms from my local machine (with :
. no network latency, a quad core
. CPU, and an SSD), which is

. perfectly reasonable. Shifting it to : jte can be hosted easily and
- an Nginx server running uwsgi saw :
. the load times jump up to 700-
. 800ms. However, the more content :
. that was added to the page, the
. longer it would take. Version 3.2 of :
. Django CMS seems to have

. improved on the speed, but it is
. not, as of writing, at a final release. : jte generator simply reduces the
: The equivalent site using Pelican (a :

~ static site generator) loads in

Full circle magazine #103 @ 10

. 402ms, and the only optimization |
. have done so far is to merge my

. CSSfiles. There is no compression

. of any sort running, and is being

. served only with python

. http.server. As the site is a

. redesign for my own company, and
. I will be the only one managingiit, |
. have no need fora CMS -1 could

. just as easily write the HTML by

. hand. However, the number of

. pages make it unreasonable to

. create everything by hand, which is
. where Pelican comes in. | can

. manage my content easily in

. reStructuredText (or, theoretically,
: anyone who knows Markdown,

: can assign various templates to the
. pages, according to the meta
. information. The resulting static

. quickly on Nginx, and use less

: resources than a Django CMS

. setup running Nginx, uwsgi, and

: postgresql. Note: this is not a

. criticism of Django CMS, as | could

. probably optimize my approach in

. order to reduce load times. A static

. amount of optimization | need to

accomplish.
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I’'M soLp! WHERE DO |
START?

There are various static site
generators on offer. The most
common and well-known is Jekyll,
which is used for GitHub Pages,
among other things. Jekyll uses
the Liquid templating language,
and is written in Ruby. I, however,
am currently using Pelican, and for
two main reasons:

It uses Jinja2 for templating,
which is the same as Django.

Meaning | could carry over existing :
. content, it should be possible too.
. iFrames or widgets from other

: sites shouldn't be an issue, or, if

© you want to semi-dynamically

. create a grid (For example), you

. can create templates using for-

. loops to iterate through

. information in order to insert it

. into HTML. If you're looking for

. login areas and personalized

© HTML, a CMS will probably be

. easier for this.

templates quickly.

It is written in Python, and so
has integrated translation options
for multilingual sites (using Jinja2
i18n). As my site is always in
English and German, this was a big
factor for me.

So, depending on what you're
most comfortable with, you may
prefer Jekyll over Pelican, or a
number of other static site
generators over either. Use what
you're comfortable with, as it will
help cut down the learning curve.
If you want to use plugins for

(For example), then | would
recommend checking the plugin

options before choosing a

generator.

. DOES THIS MEAN | CAN'T
. USE FORMS, OR ANY
. DYNAMIC CONTENT AT ALL?

what you mean by dynamic

. OKAY, I'VE INSTALLED A
. GENERATOR. WHAT NOow?
automatic integration of bootstrap :

Now would be the time to

. check the homepage and view the

documentation. As each generator

has a slightly different File
structure, and different commands

: to compile, it's necessary to check
. the documentation. Once you've

. created a project (most likely done
. with a quickstart command), then
© it's time to create some sample

. content, and a template (or to

: Forms are essentially just HTML
. that gets sent via POST (typically)
. to a php file. If you use a

: combination of Nginx and apache
. (or just apache), you can still

* include a php file for sending the

. information around. Depending on : ;
. served, there are some offerings

. where you can upload a site

. without much trouble. For

. example, GitHub Pages.

. Technically, you could even host it
. in some fashion on Dropbox. So,

. depending on your needs, you may :
. not need to pay for additional :
- hosting - or if you do, you'll most
. likely not need too powerful a

. server to adequately serve the

. content.

adjust an existing template).

Since static HTML is so easily

. SHOULD | OPTIMIZE?

: Depending on how quickly your :
. site loads, you may not feelyou
' need to. My recommendation, at

. least, is to optimize images and

* enable server compression if your
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site is going to be mobile-friendly.
Assuming, of course, that you've

. minimized your CSS and JS already.
- You'll most likely not need to do

every optimization you can for that

: last 3% decrease in size, but some
. basics are recommended.

| hope this article has been

interesting for anyone looking at,

" MY SITE IS DONE...DO | HAVE . ©Of working on, a project where you

. TO BUY HOSTING? . keep thinking “this site is almost

. too small For a CMS, but too large
. for doing it by hand!”. Or anyone

. interested in creating a quick

. project website for GitHub. If you
. have questions, suggestions, or

. comments, you can reach me at

: lswest34+fcm@gmail.com.

. FURTHER READING

Jekyll homepage:
https://jekyllrb.com/

Pelican:
https://github.com/getpelican/peli
: can

=

Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: [swest34@gmail.com.
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elcome back to the new
direction of my Python
series. In case you missed last

of this 5 year series from teaching
programming in Python to what is
called Physical Computing using
Python. When you see the phrase
'Physical Computing’, think of
buttons, LEDs, motors, sensors
(temperature, humidity, motion
sensors, barometric sensors, etc.)

do this was that after 5 years, |
thought | had shown pretty much
everything that you needed for
“normal” computing, so let's Focus
on what | consider the future of
small computer programming and
microcontrollers.

This month, | will be going over

selecting a Raspberry Pi (yes there

are more) that will fit your goals,
installing an operating system
onto the SD card and starting the
RPi for the first time with the new
OsS.

Next month, we will start
learning to respond to switches
and control LEDs. In future

HOW-T0

Written by Greg D. Walters

articles, we will be interfacing with
- sensors and the Arduino micro- :
. controller.

month, | am changing the direction

Python In The REAL World

. models were superseded by the
© RPi 2 Model B. It shares a good
: . deal with the RPi 1 B+, but has a
. A BRIEF HISTORY OF THE RP! :
. A7 CPland 1GB Ram.
© Much of this information comes
. from the official Raspberry Pi :
© website
. (http://www.raspberypi.org) and
: my memory of buying my Ffirst RPi.
. When the Raspberry Pi first came
and more. The reason | decided to : out, there were two models -
. Model A+ and Model B+. The
: decision tree was Ffairly easy since
. the two different versions fit a
: “simple or full feature” mindset, as :
: you can see in the gross details :
. presented below (They are now
. called RPi 1 Models)...

900 MHZ Quad-core ARM Cortex-

You can find various models of

: the RPi at any number of web
- retailers. My humble suggestionis : °' o
. to get the RPi 2 Model B if you can ultimate kits”. In the next few
: afford the difference in the price
. between the P1 Model B (it

: shouldn’t be that much of a delta). :
© Any of the code that we create in

: the next few articles should easily

work with any version of the RPi.

While you are searching the

web for your RPi, you will see

Raspberry Pi Model A+

Raspberry Pi Model B+

256 MB Ram

512 Meg Ram

One USE Port

4 USBE Ports (original Model B only had 2
ports)

40 GPIO Pins (original Model A only had
26 pins)

40 GPIO Pins (original Model B only had
26 pins)

No Ethernet Port

Ethernet Port
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In February 2015, both of those  various kits and add-on modules
. like cameras, servo controllers,

. motor controllers and so on. At

. this point, the add-ons won't be

. needed, but we might use some in
. the future, so if it is something

. that you are interested in use your
. own judgment. As to the kits, here
. are some things you should

. consider before you invest in the

. articles, we will need:

: « A Raspberry Pi computer.

.« A power supply. For the P1

. versions,a 5VDC 1-1.2 amp cell

. phone charger with a micro USB

. connection (normal for many smart
. phones today) will work well. For

. the P2 version, | strongly suggest
. that you get a power supply that

. has an output of 5VDC 2.5 amp

. power supply with a micro USB

: connector.

. * AUSB Keyboard and Mouse.

. While many places offer very small
. keyboard/mouse combos, for

. programming work and “normal”

. computer use, you will want a full

. size version of both. You can move
. to the small wireless versions later

on if you decide to use the RPi for
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other uses like a multimedia centre
or expanded home automation.

Normally when | work with the Pi, | :

use a VNC server on the Piand a

VNC client on my linux machine, so :
.« Speakers or headphones (unless
. the monitor or device you are

: using supports HDMI audio).

* A 4-8 GB SD Card that is Class 10. :
Versions P1 A and B used SD cards.

| don't have to have multiple
keyboards and mice on the top of
my desk.

P1 Model B+ and above have
switched over to a Micro-SD card
only support. Keep this in mind

course you can use a bigger card.
Officially they say that testing has
been done with 32 GB cards and

when buying SD cards, since they
are not all created equal. Just
because a cheap card is marked
“Class 10" doesn't actually mean
that it is going to work like a more
expensive card.

+ Some sort of Internet connection, :
. jtem. The item you will want to
- look at from Adafruit is called “Pi
. T-Cobbler Plus”. Note that this

particular item will NOT work with SETUP OF YOUR RPI

either USB Dongle or Ethernet
cable.
« A HDMI monitor/television for

output and HDMI cable. IFHDMI is :
: the RPi V1A or B. It will only work
: with the later versions. Itis

: currently about $8.00 U.S.. If you

: are using a model A or B, you

" should get “Pi T-Cobbler” which is

not available, the P1 Aand B
versions provide a RCA Composite
Video out and 3.5mm Audio Out
connector. The P1 B+ version and
later have done away with the RCA
Composite Video connector and

has replaced it with a 3.5mm jack
that combines audio and video in
one. You would need a 3.5 mm to

older TV.

While this is the “minimum”

like LEDs, resistors, switches, etc.
without having to do any

http://www.Adafruit.com For this

about $7.00 U.S. If you are looking

at SparkFun, their item is called the
“Pi Wedge”. Unless you want to

: assemble your own (read this as
: 3 RCA connectors to connect to an :

ribbon cable and use female (Pi
side) to male (breadboard side)

: jumpers. These will work,

. however, in some of the things we
. do later on, if you get the jumper

© on the wrong pin of the Pj, it could :
. lead to damage to your Pi.

: e Various Resistors, LEDs and Mini
. pushbutton switches. | will give

. you a list before we need them to
. give you plenty of time to obtain

. them. You can get these at many

. places.

.« One other thing you might

. consider is a case, but only if you

: have the breakout boards and

. ribbon cables. This will protect

. your Pi from your handling of it.

Now comes what must be for

me, the most tedious part of the
. project... the setup. The steps we
- will perform are:
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* Download the OS image.

. »Unpack the image file from the

Die y! , . archive file. Put it somewhere it's
soldering tiny parts), you will want :

. to get the Preassembled version.
: This one costs about $10.00 U.S.. |
. believe that they have retired

: (discontinued) the version for the
. RPi 1A and 1B. You CAN elect not
. to get the interface board and

. requirement list for this article, for :
. our first project you SHOULD have
. the following items available...
when buying a specific version. OF :

.« Breadboard - The breadboard

- will be needed to start working

. with add on discrete components
don’t see many issues with most of :
the larger cards. Please Be careful :
- soldering.

.« GPIO interface board (header)

. and Ribbon cable. This will

: connect the GPIO pins from the

: RPi to the breadboard. Check out
: http://sparkfun.com or

. easy to get to.

. +Installing OS to the SD Card.

: » Getting the RPi hooked up.

* First boot of the RPi with the new
. OS.

So, let's get the OS image. Go

to the downloads page on the

. official Raspberry Pi website

- (https://www.raspberrypi.org/dow
. nloads). You will be presented

: multiple versions of various images
. that you can download, including 2
. versions of Ubuntu (The GUI

. version is Ubuntu Mate), Windows
- 10 10T and more. If you have an

. older model (original models A or

. B), neither of the Ubuntu images

. or the Windows image will run on

. these models. You need the

. ARMV7 processor and the extra

. memory to be able to use these

. images.

The two we are interested in

. for this project, are the NOOBS

. and the RASPBIAN images. | will

. be using the RASPBIAN Wheezy

. image dated 05-05-2015 for our

. first few projects, but if you want

. to have the option of booting into
" other OS images on the same card,
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feel free to download the NOOBS
image. Just remember, if you have

more than one OS on the Card, you INSTALLING THE OS IMAGE

To THE SD CARD

have less space available to the
RASPBIAN image and you will run
into an issue that | always used to,

not enough space for all the things :
. of the Pi, you will be using a
you are doing your work on a Linux : standard sized SD card. If you are
- using a later version you will be

- using a Micro-SD card. To save me
https://www.raspberrypi.org/docy : having to type the distinction

. every time, | will use “SD" in the

. documentation. One more thing
. before we start. | STRONGLY
Follow the links there. I'm going to : SUGGEST that you do not use a

. device connected to an external

. USB hub for the imaging of the SD
. card. | know the specs say you can, :
. butI've never had very good luck

- doing this.

you want to try. Assuming that

machine, you can see the official
installation instructions at

mentation/installation/installing-
images/linux.md . If you are using
a Windows machine or a Mac,

assume a Linux machine and will
give you the instructions here.

Before we get started, you
might be asking why, if there is a

newer/better version available, am :

| using the older version. I've had
some trouble with the Jessie’
release and am more comfortable
with the ‘Wheezy’ release at this

with the release, probably just a

bad download, but I just wanted to actually need the sudo level

. : . permissions, but it won't hurt and

the next few articles, use ‘Wheezy’ : P . _
. neither you or | have to remember

. when they do. Now run “df -h" to

. see what devices are currently

: mounted in the system. My system :

let you know. For the purpose of

and feel free to play with other
versions.

Unpack the archive and have it
be sent to a folder that will be easy

for you to remember.

If you are using an early version :

OK, here we go. Before

. inserting the SD card into your
. Linux box, open a terminal and do:

: . . : d -3
time. | doubt that this was an issue suge =

Most of the commands don't

responds as shown below. Yes, I've
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named my machine Slartibartfast.

i Slartibartfast ~ # df -h

! Filesystem Size Used Avail Use% Mounted on
: /dev/sdal 451G 336G 93G 79% /
! none 4.0K 0 4.0K 0% /sys/fs/cgroup
udev 3.9¢6 4.0K 3.9G 1% /dev
. tmpfs 796M 1.5M 794M 1% /run
! none 5.0M 0 5.0M 0% /run/lock
: none 3.9¢ 124M 3.8G 4% /run/shm
: none 100M 32K 100M 1% /run/user
: /dev/sddl 2.8T 2.5T 314G 89% /media/greg/TOSHIBA
: EXT
: /dev/sdbl 1.8T 1.5T 294G 84% /media/greg/extramedia
: /dev/sdcl 917G 681G 190G 79% /media/greg/MoreMedia2

. Slartibartfast ~ #

Notice that | have 4 drives (sda1, sdb1, sdc1 and sdd1). | hope that when
. I plug in the SD card, it will come up as /dev/sde1. This will be important
. to know because if we get the wrong /dev/ device, we will corrupt it!

Now plug your SD card into the computer and run “df-h” again. My

. system responds as:

. Slartibartfast - # df-h

: Filesystem Size Used Avail Use% Mounted on

: /dev/sdal 451G 336G 93G 79% /

: none 4.0K 0 4.0K 0% /sys/fs/cgroup

i udev 3.9¢6 4.0K 3.9G 1% /dev

. tmpfs 796M 1.5M 794M 1% /run

: none 5.0M 0 5.0M 0% /run/lock

! none 3.96¢ 124M 3.8G 4% /run/shm

! none 100M 36K 100M 1% /run/user

: /dev/sddl 2.8T 2.5T 314G 89% /media/greg/TOSHIBA

: EXT

. /dev/sdbl 1.8T 1.5T 294G 84% /media/greg/extramedia
: /dev/sdcl 917G 681G 190G 79% /media/greg/MoreMedia2
: /dev/sdel 56M 20M 37M 36% /media/greg/boot

: /dev/sde2 30G 3.0G 25G 11% /media/greg/13d368bf-

: 6dbf-4751-8bal-88bed06bef77
! Slartibartfast — #
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Thank goodness! However

/dev/sde1 has two partitions. This

will be important in the next step.
If you are me, please write down
the drive information so you don't

make a mistake. Now you will want

to unmount the SD card drive.

Slartibartfast ~ # umount
/dev/sde2

Slartibartfast ~ # umount
/dev/sdel

Slartibartfast ~ # df -h

Notice that | started yet
another “df -h" just to verify that
the device is unmounted.

If you have ever used this SD
card for anything before, you will
want to remove the partitions
before proceeding further. Some

necessary, but why not? It only
takes a Few seconds and it keeps
us from having problems. Use
“gparted” to remove all the
partitions.

Slartibartfast Raspbian # dcfldd bs=4M if=2015-05-05-raspbian-wheezy.img of=/dev/sde

768 blocks (3072Mb) written.
781+1 records in

781+1 records out
Slartibartfast Raspbian #

We are about to write the

. Raspbian image to the SD card.

. There are two ways to do this.

: First is to use the “dd” command

. AS SUDO, which I'm sure will be

. the First thing that comes to

. everyone's mind. However,

. remember when we use “dd”, we
. don't get any information coming
. back to tell us what is going on and :
- if it takes 5 minutes or longer to

. write the image, we won't see

. anything that entire time in the

. way of progress. While there are

. other methods I'm going to

: suggest that instead, you can use

) 7 . the “dcfldd” command (shown top
people might argue that this is not - right). Once it gets started (which
. could take a minute or so) it will

: give a progress report about how
. much has been written. Pick your
. “"weapon” of choice. I'm going to

. show “dcfldd”. Now, as SUDO,

. please change to where ever you

Slartibartfast Raspbian # 1ls -al

total 7424016
drwxr—-xr—-x 2 greg greg
drwxr—-xr—-x 3 greg greg

4096 Oct 31 12:02 .
4096 Oct 23 20:11 ..
-rw-r——-r—— 1 greg greg 3276800000 May 7

Slartibartfast Raspbian # dd bs=4M if=/dev/sde of=wheezy-

2015-11-07.imgsafe
7609+1 records in
7609+1 records out

31914983424 bytes (32 GB) copied,

1675.51 s, 19.0 MB/s

Slartibartfast Raspbian # truncate —--reference 2015-05-05-
raspbian-wheezy.img wheezy-2015-11-07.imgsafe
Slartibartfast Raspbian # diff -s wheezy-2015-11-07.imgsafe

2015-05-05-raspbian—-wheezy.img

Files wheezy-2015-11-07.imgsafe and 2015-05-05-raspbian-

wheezy.img are identical

. have unpacked the image you are
. going to use.

On my machine, the process

. took about 10 minutes total.

This next step (above) is totally

2015 2015-05-05-raspbian—-wheezy.img

—-rw—-r——r—— 1 greg greg 4325376000 Sep 24 16:14 2015-09-24-raspbian—-jessie.img

Slartibartfast Raspbian #
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. want to verify the write so that

: you can be sure that this matches
. the image. We will make an image
: | show (below) an “ls” command :
. here. I do this so | can remember

. the name of the file that I'm just

. about to work with, and | have the
. exact spelling.

of the SD card we just did and

. write it to a temporary image file

. back to the hard drive. Since your

. SD card will likely be bigger than

. the one they used to create the

. distribution image, we will need to
: truncate our copy to match the

. size of the original and finally use

. diff to verify that both images are
; . the same. Remember this could

. optional, but if you are like me, you :
: 3 card larger than about 8Gb. I'm
: using a 32Gb card and it looks like
. it's going to take probably 30+

: minutes to copy the image to the
. drive.

take a rather long time if you have
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As you can see, the images are
the same, so if there is anything
wrong from here until we log in,
it's not our fault. This process

could be a useful process as you go
- and get it set to the proper mode
. (HDMI or Composite).

along and want to make a backup
image of your Pi's “drive”, just in
case something happens.

Finally, we want to run the sync

command which will make sure
that anything remains
uncommitted in the write cache is
flushed and that is ok to unmount
the SD card.

Now we can move on to some
more “exciting” things. Powering
on the Pi.

GETTING READY TO POWER
UP YOUR RPI

Notice how | worded the
heading for this portion of the
instructions. There are certain
things you should do before you

possibilities you can damage your
RPi if you don't do the steps in
order.

Plug in the Keyboard and
Mouse into the USB port/ports.

Plug in the Ethernet cable into
the Ethernet port or Wireless

. dongle into the USB Port.

Switch on your monitor or TV

Plug in the video cable (HDMI
or Composite).

Put the SD card (or Micro-SD

: card) into place. It doesn't matter

© if you are using a full size SD card

: or a Micro-SD, you will insert it

: with the label facing down, not up
: towards the bottom of the Pi. And
. whatever you do, DO NOT remove
. the SD card while the RPi is
. powered on.

At this point, we are ready to

plug in the power, so take a deep
breath and cross your body parts.
. Plugitin.

Once you get Pi booted into a

- distribution for the first time, you
. will presented with the raspi-

: config application. We are going

" to want to tweak some of the

settings. We only really need to do

this once.

You will see a screen with 9

. options on it. We will work with

: numbers 1,3 and 4.

.« Option #1 - Asks about

. expanding the file-system. You

. really want to do this so you can

. get the most space you can. It will
. take effect at the next reboot.

.« Option #3 - Enable boot to

. Desktop/Scratch. You should go

. ahead and set this to Desktop

. Login as User 'Pi' at the Graphical

. Desktop.

L Option #4 - This sets various

. things that we take for granted by

our automated setup systems.

* First select Locale. Since this

. computer comes from the UK, its
. default is to select things that

. someone living there would need.
: |, on the other hand, need to

. change some settings. | have to

. Ifit worked, then we'll move on. :
. If not, please retry the instructions :

apply power to your RPi. There are : jpgve.

let the window scroll down to
EN_US.UTF-8 UTF-8 and select it.

Follow the prompts and you'll be
- fine.

* Next | need to set my time-

: zone. Since | live in Colorado, USA, |
. would select America under the
. Geographic area, and Denver for
" the Time Zone.

* Finally | have to select the
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keyboard layout | wish to use. It
asks a lot of questions, so | would

. select “Generic”, "US", “US",
. "Default”, "No Compose Key"” and
: “No” to Xserver Termination key.

Finally I'm ready to set it up, so |

. select “Finish” and “yes”. Your Pi

. should reboot and you should see

. the normal desktop. Now we want
. to update the system to the latest,
. add a couple of applications that

. we'll need right away and then let

. it reboot once again.

Open a terminal off the top

. menu bar and do:
. They include Locale, Timezone and : sudo apt-get update

: Keyboard Layouts. E sudo apt-get dist-upgrade

Now we want to install

. TightVNCServer. While this is an

. optional step, | find it much more

. constructive to use the Remote

. window on my Linux desktop than

. be forced to have 2 monitors,

. keyboards and mice. It always gets
. me confused about what/where |

- am.

sudo apt—get install

: tightvncserver

Once that's set up, it will ask

you to create a password, so no
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one can just jump into your screen.
Make it easy for you to remember.

The very next thing we want to
do is set the tightvncserver to
automatically startup on boot.
That way we don't have to have a
mouse or a keyboard.

* Change to the home directory if

you aren't already there.
$ cd /home/pi

* Next, change to the .config

directory.
$ cd .config

* Now we will make a new

directory here called 'autostart'.
$ mkdir autostart

we just created.
$ cd autostart

* Now create a new configuration
file. $ nano tightvnc.desktop

And enter the following lines:
[Desktop Entry]
Type=Application
Name=TightVNC
Exec=vncserver :1
StartupNotify=false

« Save the file (*0O) and exit (*X).

Almost done now. The last
thing we will need to do is install
the IDE we will be using for our

code development, which is Geany.

sudo apt—-get install geany

Move over to your normal
computer and load VNCViewer

. software on it. Once that's all

. done, you will probably want to
. spend a moment or two by

. rebooting the computer and

. making sure that the VNC really
. did start up and connect. If

. everything works, you are done.

© You will need (as | said earlier) a :
. few things for next month. Some :
. male to male jumpers, female to

: female jumpers, the breadboard,
: interface and cable and a handful
: of things from the electronics

. store...

» Change to the autostart directory :

: »Some small LEDs. Try to get

- around 10 of each Red, Green,

© Yellow and Clear. :
.« Some small Vs watt resistors. 220 :
. ohm, 4.7K ohm, 10K ohm, and :
. some other “normal” hobbyist

: resistors. About 10 each will do

: you and the salesperson at the

- local shop should be able to get

© you what you need.

.« A couple of small switches (spst)
: that will fit on the breadboard.

: (usually comes with 4 pins).

Really that's about all you will

need for the next article. In the :
" meantime, enjoy playing with Linux

on the Pi. | think you will be

surprised by the power of this tiny

device.

So until next month, the last

thought | will leave you with is
something we hear here in the U.S.
- all the time...

P
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Greg Walters is owner of RainyDay
Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1972. He enjoys
cooking, hiking, music, and spending
time with his family. His website is
www.thedesignatedgeek.net.
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ubuntu

m(’)] uk podcast

The Ubuntu Podcast covers all
the latest news and issues facing
Ubuntu Linux users and Free
Software fans in general. The
show appeals to the newest user
and the oldest coder. Our
discussions cover the
development of Ubuntu but
aren’t overly technical. We are
lucky enough to have some
great guests on the show, telling
us First hand about the latest
exciting developments they are
working on, in a way that we can
all understand! We also talk
about the Ubuntu community
and what it gets up to.

The show is presented by
members of the UK’s Ubuntu
Linux community. Because it is
covered by the Ubuntu Code of
Conduct it is suitable for all.

The show is broadcast live every
fortnight on a Tuesday evening
(British time) and is available for
download the following day.

podcast.ubuntu-uk.org
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HOW-T0

Written by Elmer Perry

l

hen you have some datato

analyze, do you gather your :
data into a spreadsheet, format :
the sheet, and then stare for hours :
at the numbers wondering what
they mean? No! You create a chart
that represents the data. While a
chart can help you see the overall
results of the data, how do you
examine how individual data-
points fall into the overall scheme
of things? Conditional formatting
can help you focus in on the data-
points making up your data set.

LibreOffice PE.54' - Conditional Formatting

The range or condition is

controlled by 6 different methods

- for calculating values. Let's look at

each of the methods.

© « Minimum - The smallest value in
: the data set.

: « Maximum - The largest value in
: the data set.

: « Percentile — The percentile

: ranking of each value within the :
© minimum to maximum range of the :
© data points. :
: «Value - The value is based off a
: fixed number you enter.

: « Percent — The part each value is

LibreOffice provides us with
many different conditional
formatting options, allowing us to
find a setup that will work for
many different types of data. We
discussed one of the conditional
methods back in part 43 under
statistical functions (Full Circle 91). :
Today, | want to add three more
conditional formatting options to
your data analysis arsenal, Color
Scales, Data Bars, and Icon Sets.

of the total sum of the data set.
- » Formula - The value is set by a
cell reference or a formula.

While percentile and percent

: may seem like the same thing, :
: mathematically they are different. :
© A percentile breaks the difference :
. between minimum and maximum
© into 100 pieces and reports where
: the values fall in those 100 pieces.
© A percent shows how much the

- value is of the total sum of all the

METHODS OF CALCULATION

In all three methods, you create 5
a range or condition for your data.

numbers in the set.

. COLOR SCALE

Color Scale is a conditional

- Format that highlights values in a

Fill Series . gradient of chosen colors
o Series Type . depincillng on their valycle(. ThIS [
@ Down ® Ligear ® Day- method gives you a quic visua
Right ® Growth e clye .about where a value lies
Up Date .1o; Wwithin the overall range. You can
Left @ AutoFill ...: use 2 or 3 colors to create your
. scale. | will demonstrate both.
Start value: (1 :
End value: : We will set up arange of values
Ingrement: |10 . to demonstrate how the scale
| Conditions
;Cnndttionl
All Cells |T| Coler S5cale (2 Entries) |T|
Min |T| _Max |T||
| | N Red 3 [=] I Glue 3 [=]
add | [ Deete
‘|| CeltRange
‘| Bange |A110 (]
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works. The range we are creating is :
linear so you can see the way the
colors graduate from one to the
other. Start by entering the value 1 :
in the cell A1. Select cell range
A1:A10. Edit > Fill > Series. In the
dialog, select Down for the
direction, Linear for the Series
Type, and 10 for the Increment
value. Click OK. The values will fill
in. Now, select cell range A1:J10.
Edit > Fill > Series. Select Right for
the direction, Linear for the Series
Type, and 1 for the Increment
value. Click OK. If you did
everything correctly, you will have
the values from 1 to 100in 10
rows.

numbers are highlighted by a

. gradient of colors starting with the :
. default red and blending more

with the blue until it gets to the

. center, then the red starts to fade
© out as it graduates back to blue at
. the end. So, you can see here how
. the scale works. If your number is
- highlighted in a purplish color, you :
. know that it is a mid-range value. :
. The more red, the closer to the

. beginning; the more blue, the

- closer to the end.

We can add a third color to the

scale, increasing the visual effect.
. Format > Conditional Formatting > :
: Manage. Select the condition in

. the list and click Edit. Switch the

Now, let's set up our Color
Scale. If not still selected, select
cell range A1:J10. Format >
Conditional Formatting > Color
Scale. Color Scale is always set at
All Cells. Set the top center
dropdown box to Color Scale (2
Entries). Leave the rest of the
settings at their default values.
Click OK. Notice the range of

. top center dropdown to Color

: Scale (3 Entries). The three center
. entries relate to the third color.

. Select Percentile for the type, 50

. for the value, and Green 3 for the
- color. Click OK. Click OK again to

. close the Manage Conditional

. Formatting dialog. You now have

" two color gradients. Red to green,

green to blue. The more green, the

closer to the middle. It might help
to format the cells font color to

# | white so they stand out against the
. colors better.

B DATA BARS

Data Bars are like a quick-and-

- dirty bar chart right in your
. spreadsheet, creating a data mixed :
. with chart effect. To make data

. bars look good, it helps to make

. the columns a little wider. We will
. place our data bars data at the end :

. of our previous table so you can do : Conditional Formatting > Data

just that.

To set up our data for the data

. bars, select the cell range L1:L11.

. Edit > Fill > Series. In the Fill dialog,
. select down for the Direction,

. Linear for the Fill Type, -50 for the

. start value, and 10 for the

- Increment. Click OK. The data will

. fill in fFrom -50 to 50 in increments

- of 10.

To create the data bars, select

. the cell range L1:L10. Format >

. Bars. Just like the color scale, the

Conditions
Condition 1
|AII Cells Data Bar

!ﬁ«utum atic =l

More Options... |

[=]

Automatic |L

Cell Range

Range: |L1:L11

(=]
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setting must remain on all cells.
You can use any of the calculation
methods to create your upper and
lower range, but leaving it on
automatic shows the best results
for our data. Click OK. You will see
that the cells are split in half. The
negative numbers grow to the left
in red, and the positive numbers
grow to the right in blue. Notice
the gradient scale on both colors.

But that's not the end of this
story. Did you notice the More
Options button? Maybe you even
clicked on it. You're the type who

Data Bar =

Entry Values

Automatic |T|

|

Automatic | = |
L]

Minimum:

Maximum:

Bar Colors
B Elu=3

. Fed 3

Positive:

Megative:

Eed B =]

Eill: |Gradient
Axis
Posttion of vertical adas: |Automatic

Color of vertical aoas: |l Black

][]

Bar Lengths
Minirnum bar length (%)

Maximum bar length (%)

Display bar only

oK Cancel |

likes to get ahead, aren't you? Well,
let's go back and take a look at

: those options. Let's edit our data
: bar range, Format > Conditional

: Formatting > Manage. Select the

: Data Bars range (L1:L11) and click
. the Edit button. Finally, click on the:
: More Options button.

Here you can adjust the

: minimum and the maximum just

. like in the dialog. The Bar Colors

. options allow you change the

. colors for positive and negative

. numbers. The Fill lets you change
: from Gradient to Color (solid).

. Position of the Vertical Axis ;
. changes the position of the center
. or zero line. Automatic will adjust
. its position depending on the type
. of numbers you have. For positive :
. numbers, it automatically left-

. justifies the bars, but for negative
: numbers, it automatically right-

© justifies the bars. For a mix of

. positive and negative numbers,

. Automatic centers the 0-axis line;
. Middle forces the vertical axisto
. the center of the cells; None forces :
. the bar to left-justify, even the
: negative numbers. With None, the
. only way to know positive from
: negative is by the color. Using

: Middle or None for the vertical axis :
" activates the Bar Lengths. Here

you can adjust the minimum and

maximum lengths as a percentage.
If you want all values (except zero)

. to show a bar, you can set the
. minimum to 1. Or, if you don't want :
. the bars to go all the way to the
. left or right, you can set the :
maximum to something other than :
© 100 (say 80). Play around with :
. these options to see what kind of
. results you get. The Display Bar

. Only check-box causes the cells to
© just show the data bars and hides
: the number values.

40
-30
20
-10

10
20
30
40
50

. IcoN SETS

Icon sets are used to show

. whether a value is below, equal to,
. or above a defined value. The icon
. sets come in several varieties, and :
. in sets of 3, 4, or 5 icons. Use them
- according to the style and number
. of icons you need. We will setup a
- group of random numbers,
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average them, and then use three

~ arrow icons to determine whether
. the values are above or below the

daverage.

¢ |Randoem Musrier Gererator 3

Dlata

§5heetl 5A513-54524

El

Cell range

Random Number Generator

Dhstribution: Unifonm Integer -
Minimurm 5
Maximum 30,000
Options

Enable custom seed
Send

Enable rounding
Decirmal places:

Help Bpply oK Clase

For the setup, select cell range

. A13:A24. Edit > Fill > Random

. Number. Set Distribution to

. Uniform Integer, Minimum to 50,

. and Maximum to 50,000. Click OK.
. In cell C13, enter the formula

. =AVERAGE(A13:A24).

irvditiaral Foemattiesg tor L334

rrrrrrr

D |Cel Range

Barge  A1EAM
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To set up ouricons, select cell
range A13:A24. Format >
Conditional Formatting > Icon Set.
Change both of the dropdown
boxes to the Formula method. In
the Ffirst text-box with the yellow
right-pointing arrow, enter the

Formula as =C13. If the value of the
- the ability to give visual clues

. about the values in a spreadsheet :
. without having to create a chart or
. graph. Color Scale sets the :

cell equals the value in C13, the
yellow arrow will show in the cell.
If the value of the cell is less than
the value of C13, the red down-

arrow will display in the cell. In the

second text-box, enter the formula :
. Data Bars creates a mini bar-chart

- directly in the cells. Icon Set marks :
. the cells with icons based on their :
. conditional relationship to some

- value. Each method has its own

. function, giving you a different

- style of results. Just like when

=CEILING(C13, 1, 0). The CEILING
function takes the number
provided, in this case the value in
cell C13, and rounds it up
according to the value in the
second argument. Since we have 1
as the second argument, the

Function will round the number up
. to make the decision about which

. one works best for your
- application.
numbers are rounded according to

to the next whole number. The
third value, set at 0 in our case,
controls whether negative

their actual value or absolute

value. In order to round based on
the absolute value, you would set
the third argument to something

other than 0 (zero). Click on the OK
button, and the arrows will show in :

the cells based on their
relationship to the value in C13.

11697.333
14 | 15116 :
D115 | 5297
1|16 |9 10314
17 | 4631
118 |@ 8573
|19 |4 16983

Conditional Formatting gives us

background color on a cell - based
on its value within a defined range.

creating a chart or graph, you have

P
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Elmer Perry's history of working,
and programming, computers
involves an Apple ][E, adding some
Amiga, a generous helping of DOS
and Windows, a dash of Unix, and
blend well with Linux and Ubuntu.
He blogs at
http://eeperry.wordpress.com
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Written by John Eddie Kerr

BibliographiesiIn LaTeX

Cis

be catalogued by Zotero, all with a

or this edition of the LaTeX . thousands of YouTube videoson : ALTeditor = {editor},
segment | will tellyou a little : how to use Zotero. There are also : click of a mouse. ;;}Eiis;eitit?{-gt}ﬂ;lisher} ,
bit about BibTeX and how it can  : very good videos on how to create : . year = {year},
help you. To help liven up a dry - citations and bibliographies. - Itisthese little 8ggt§}{u;e{]fe¥\}r<’>lume}
subject, I'll compose an ultra-short : . iconsthatdoallthe |2 8@ - = OPTnumber = {number}
paper, and I'llinclude information i  What does Zotero do foryou? @ magic for you: . OPTseries = {series},
about that great album by the . Suppose you are conducting :  OBToditiom = fodition:!
Beatles: “Sgt. Pepper” —thatyou : research for a term paper. You are : Z opens the Zotero database; | oprmonth = {month},
probably did not know about! But : searching online for journal . the blue book icon downloads the : OPTnote = {note},
irst... you need to know abouta  : articles. When you find one thatis : bibliographicinformation - note C}’PTanmte = {annote},

bibliographic software called
Zotero.

Zotero is a plug-in for Firefox.
To describe it well, I will post a
quote here from the Zotero
website:

“Zotero is the only research tool

that automatically senses content in :

on point for your paper, you can

. click a tiny icon on your browser
and all of the bibliographic

. information that you need is
downloaded to your own database.
: You also have the URL for the
article, and a copy of the article is

: downloaded to your computer. :
Zotero can download bibliographic :

data for any book you find in a

that different icons appear for
: various types of media.

So where is the connection to

. LaTeX? And BibTex?

Zotero will export your data in

© many forms, one of them is the

BibTeX format and it looks like thls

. @Book{ID,

Many LaTeX editors will create

. the appropriate template for the

: item you wish to record. Quite

. simple to use, inside the {} we just
: type in the information required.

. The most important field is the

. Field on the Ffirst line. “ID” must be

a unique identifier or “key”. So, for

: a book I would have written, the

i . library catalogue. Almost anythin : "
’ our.web browser, allowlng you .to : y caraiog ything . ALTauthor = {author}, . key could be “jek2015".
add it to your personal library with a : thatyou find on the Internet can :
single gl/ck. Whether you're @book {martin little 1994,
searching for a pre-print on address = {Boston},
arXiv.org, a journal article from edition = {1lst U.S. ed},

title = {With a little help from my friends: the making of {Sgt}. {Pepper}},
JSTOR,. a news story from the New isbn = {978-0-316-54783-3}
York Times, or a book from your : shorttitle = {With a little help from my friends},
university library catalog, Zotero has : publisher = {Little, Brown},
d with tf : author = {Martin, George and Pearson, William},

you covered with support for year = {1994},

thousands of sites.”

And, just like LaTeX, there are

keywords = {1961-1970,
{Includes index}

annote =

Beatles,
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England, Rock music},
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It would be tedious to type in

all of that information, but at least .

this way you have to type it only
once. But Zotero can do all of that
for you, here (previous page,
bottom right) is a citation that |
harvested from the catalogue at
my local library with a click on the
blue icon in my browser.

All that typing was done for you

with a click of a mouse way back
when you were searching the

the record, highlight the record
(multiple records can be done by
holding down the ctrl-key while

for the bibliography).
Right click and choose Export

Iltems, scroll in the next window to
BibTeX, then click OK.

Sometimes we may want to
tweak the records. | would change:

; martin_little _1994

to
g gmartin94.
; @book{gmartin94,
: address = {Boston},
edition = {1st U.S. ed},

Unfortunately, we can edit the

. record key only in the BibTeX file,
library online catalogue. To export . not the Zotero file. So if you have a
. BibTeX File that you have modified, :
: and then you want to add another
: record, you will have to export that :
you click on other records required : record to its own file and then copy :
: and paste the data into the main

. BibTeX file.

Now, sometimes we have to

manually enter records, | find that
: for recording websites, Zotero

B interview: David Marsden

[_] Keith Richards Trashes Beatles' ... Kenneally

= with a little
|=|] Zotero Quick start Guide

2lp from my Friend... Martinand Pear...

Center For Hiskto...

does a great job but the BibTeX
output can enter many excess '{}'

. that have to be edited out. Just a
: warning.

Here is a record that | created,

! @misc{_interview_?7?7??,

i

! title = {Interview : {David}

: {Marsden}},

Purl = :
! {https://www.nythespirit.com/ :
: publisher = {unpublished},

; annote = {When I heard

! Sargent Pepper I knew that :
: rock music had to move to the :
! FM band because AM just could :
: not deliver the sound that
: the rock musicians were

! making. At that time, :
! band was the sacred ground of :
: classical music. :
! tough fight and it took a
: year for it to happen.}

the FM

It was a
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SO HOW DO WE GET THIS ALL

: TO WORK?

The bibliography file must end

with the letters bib (Zotero does

. to record a conversation | had with that for you), and must also be in

. one of the pioneers of FM rock,
: David Marsden of the Internet
: radio station

. https://www.nythespirit.com:

: the same directory as the File that

. your document is in. (Creating a

. directory for your LaTeX document
. is the first rule of LaTeX).

The bibliographic file in this

project is called Pepper.bib.

In the preamble add this line:

: \bibliographystyle{plain}

To your document at the end,

just before /end{document}, add
. this line:

! \bibliography{the name of
i your file.bib}

or in this case:

; \bibliography{Pepper.bib}.

The name of the File is case

sensitive so make sure that you
:  Theannote field is a good place :
© to enter any text that you want to
. quote in your paper.

type the name of the file exactly.

There are many bibliography

styles to choose from but | will just

use the plain style in my ultra-short
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paper. Here are some sites that
cover the bibliography style in
more detail, with examples:

http://www.cs.stir.ac.uk/~kjt/softw

are/latex/showbst.html
http://www.reed.edu/cis/help/LaT
eX/bibtexstyles.html#seven

Many colleges and universities
have information regarding
bibliographic styles, and also
LaTeX templates for a thesis, on
their websites; enquire at the
institution you are attending.

Whenever you want to cite a

source in your paper, type \cite and :

your LaTeX editor should list the

citations in your BibTeX File for you :
y Y . once to get the bibliography to

to insert:

Many Canadians know that Sgt.

Pepper is a real person and George Martin

reveals his identitv for those who do not know. _’!J'
Sgt. Pepper was more than just an iconic album, it had a huge impact on

radio broadcasting:

Pepper 1 knew that rock music had to move

to the FM band because AM just could not deliver the sound that

When I heard Sgt.
the rock musicians were making.
the sacred pround of classical music.
a vear for it to happen.
References
[1] Interview : David Marsden.

At that time,

the FM band was
It was a tough fight and it took

David Marsden [1]

2] George Martin and William Pearson. With a little help from my friends: the

making of Sgt. Pepper. Little,

Brown, Boston, 1st ws. ed edition, 1994,

w. \cite]

¢pe 0 ‘u:lte{ mtemew 77T}

Lmpa \cite{martin94}
quot
ar‘a:::te[ H }

to

+ I

The bibliography is created
when you compile your document
and it all will look something like
this:

Sometimes you may have to

. compile your document more than
. in the directory of the document

: compile, that can be normal. . you are creating.

rge Martin reveals his ideni:
: This article has just scraped the :
. surface of the bibliography

. component of LaTeX. There are

. other ways of approaching this,

- and there are many other options
. in the BibTex bag of tricks. There is :
- anew format called BibLateX, and
. Zotero will export bibliographies in :
. this format as well. However | must :
. say that — thanks to the BibTex

. export feature that we have in

. Zotero, and that Zotero makes

- data harvesting from databases so

easy — | am in favour of the BibTex

| wish | had LaTeX and BibTeX

- way back in the days when | was
. writing my papers at University,
. back in the days when FM stereo
- was about as high tech as it got.

Today, with a little help from your

. friends (all those people who have :
created the free software), writing :
a class paper is so much easier. | am :
. green with envy. :

A shameless plugis in order. If

you would like to hear what FM

Rock radio was like in the early
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years when the DJ's could practise

~ Free Form FM radio (that was

. before the suits discovered there

: was more advertising revenue to

: extract), | encourage you to

. explore David Marsden's own show
: on Saturday and Sunday nights

: 8:00 pm Eastern time at this site:

- https://www.nythespirit.com/.

. Code “BEMX" will give you a one-

: month free trial.

By now | suppose the suspense

- is killing you, and you have to know
. the identity of the real Sgt. Pepper.
: He was a policeman who was on

. the security team when the

. file method which is creating a .bib : g\ (a5 visited Toronto. That

file of your references that resides morsel of information is on the last
. page of Sir George Martin's book

- which is full of interesting tidbits.

- It is a must read, | enjoyed it. Until

© next time, enjoy LaTeX.
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HOW-T0

Written by Attila-Mihaly Balazs

Practice Your Programming

CiS

rogramming is an activity
where you need to

A programming Advent

: calendar is such a collaborative

THE PERL 6 ADVENT

. SYSADVENT

: : . https://sysadvent.blogspot.com
continuously learn to stay . blog centering around one hct‘to‘le'E/'/‘lDe‘:IGRadvent wordpress.co
productive. Programming : language / framework / library or m/D /[P . p . - Interesting articles for system

languages, libraries, tools,
operating systems - they all

change. This means that last year's :
- 1st and 24th of December to find a :

: surprise, these blogs publish one
© article each day for the first 24

: days of December about their

: respective topics surprising,

: informing and delighting their

. readers.

solutions that you find on the
Internet might not be applicable
this year. Thus we need new
content (be it blog posts,
documentation, books or other
forms) showing the current best
way to achieve a given goal. One
solution is StackOverflow with its
voting system (where out-of-date
solutions get voted down and
working solutions get voted up)
and others are blogs. The problem

. subsection of the IT field. Just as
. you open one door of an Advent

calendar every day between the

Some of the programming

. Advent calendars are:

. JAVA ADVENT CALENDAR

Perl 6 is a new programming
. language to be released this

. PERLADVENT
. http://www.perladvent.org/

© If you're not ready to make the
© jump to Perl 6 yet (since it's a

- completely new language, not just :
© asuperset of Perl 5), here you can
© find all kind of interesting details

: administrators and anyone curious
. about the field of IT.

. UXMas

: Christmas, so if you're interested in

. Perl 5, this is a good site to follow  http://uxmas.com/

“An Advent calendar for UX folk.”

. PERL DANCER ADVENT

. CALENDAR
: http://advent.perldancer.org

“The PerlDancer Advent Calendar
: is a community-driven project that

with blogs is that people rarely  : hitp://www.javaadvent.com/ . aboutit. © aims to showcase the Dancer Perl
have time to blog frequently : : : web framework.”
and/or don’t have expertiseanda : |'m partial to this, having started it | 24WAYS :

diverse set of domains, thus
readership interest can waver.
There are tries to encourage
people to blog regularly (such as
the Perl Iron Man Blogging
Challenge), however, it is easier to
sustain a blog with multiple
authors (also called collaborative

blogging).

© 4 years ago :-). It contains articles
: about all kinds of technologies

© related to the Java Virtual

© Machine, not just Java the

: language. For example, we had

: articles about two of the oldest

© languages running on the JVM

. (besides Java): NetRexx and Kawa.

https://24ways.org/

you all a little Christmas cheer.”
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24 PuLL REQUESTS

: : http://24pullrequests.com
: “24 ways is the Advent calendar for : pi/{24p . /

: web geeks. For twenty-four days

. each December we publish a daily
: dose of web design and

. development goodness to bring

© This isn't a collaborative blog, but
© rather an effort to encourage

. people to contribute to free /
open-source software on GitHub
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HOWTO - PRACTICE YOUR PROGRAMMING

QIITA ADVENT CALENDARS
http://qiita.com/advent-calendar

There are a lot of topics covered
here (and I mean a lot-in 2014
they had 214 different Advent
calendars with different topics).

Unfortunately, you need to be able

to read Japanese to enjoy it.

These are the ones which are

currently active (there were others :
which unfortunately are no longer

available).

You can subscribe to any of
these using your favorite RSS
reader (Ffor example Liferea,
RSSOwl, feedly, NewsBlur and so

on) to ensure that you never miss a :

post. Some of them (like
JavaAdvent) also offer other

means of subscription (like Twitter,
Facebook, Google+ or even email). :

Finally, all of these sites
welcome (and in fact depend on)

user contribution. So go ahead and

subscribe to them and also
consider writing an article or two

yourself! As they say: the best way

to understand something is to try
to explain it to others!
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HOW-T0

Written by Mark Crutch

>

efore we delve too much

further into Live Path Effects,
there are some implementation
details that are worth pointing out. :
The Ffirst is that LPEs don't exist in
the SVG specification. They're an
Inkscape-specific thing, and no
browser or other SVG editor knows :
how to render them. Go on, give it
a try. Create a nice chain of gears, :
or a Spiro path, then save your SVG :
file. Openitin a modern web
browser and see what you get.
Here's my file, opened in Firefox.

. answer can be found by looking at
: the XML code for the file, either

. via Inkscape's XML editor (Edit >

. XML Editor, or CTRL-SHIFT-X), by

. viewing the page source in your

. browser (CTRL-U in Firefox), or

. simply by opening your SVG file in
. a text editor. You'll see that the

: main body of the image is made up :
. of an SVG <path> element. The “d” :
- within Inkscape, it automatically
. updates the “d"” attribute to match :
. the rendered output, so other

. applications should always be able
. to display your drawing as

attribute contains a series of

letters and coordinates that tells
. an SVG-aware application how to
. draw the final path, after any

. visible LPEs have been applied. It's

El Mazilla Firefas
+) 8 Smsppomummtane - | = |NEIN + #- a0 E|:

lecvhomate Agean gy | & =

like a snapshot of the result, in a
. format that your browser
- understands.

Notice that there are some

. other attributes, in the “inkscape”
: namespace. In particular you'll find
. “inkscape:original-d”, which holds

. the path definition of the original,
. skeleton path. There's also an

. “inkscape:path-effect” attribute,

. which holds a semicolon-separated

- list of XML IDs. These refer to

Well, it certainly looks like my
original Inkscape Ffile, but how can
that be if the browser doesn't
know anything about LPEs? The

. <inkscape:path-effect> elements
. up in the <defs> section of the
. XML, which is where all the

parameters for your effects are

Inkscape - Part 43

stored.

So, in summary, Inkscape uses

. the “original-d” attribute and

. <path-effect> elements to hold all
. the information it needs to draw

. the LPE. Other applications use the :
: “d” attribute to render a snapshot

of the final path, with the LPE
applied. When you modify an LPE

. intended, even though they don't
. know anything about LPEs.

Inkscape doesn't always do a

. great job of clearing out unused :
. elements in the <defs> section of a
file, and path effect definitions are
. use the Path > Object to Path

. menu entry (CTRL-SHIFT-C). It may
. seem odd to use Object to Path on
. something that's already a path,

. no exception. If you add and

© remove a number of LPEs whilst

. experimenting with your drawing,
. old definitions tend to build up

. there. They don't do any harm, but :
. do slightly increase the size of the
© file. You can clear them out,

. together with other unused

. definitions, by using the File >

" Clean Up Document menu entry

Full circle magazine #103 @ 28

(File > Vacuum Defs on 0.48).

Because Inkscape calculates the

final path from the original path
. and LPE parameters, using live
. path effects places more of a

burden on the processor, resulting

. in slower rendering speeds. Usually
. thisisn't anissue, but when

. zooming into a very complex

: drawing it can become noticeable.

If you're happy with the LPE

. output, and don't need to change

. it any further, you can “fix” the

. path so that it looks the same, but
. is no longer based on path effects.
. Essentially this process just

. removes the Inkscape-namespaced
. attributes from the path element,

. leaving it with just the same “d”

attribute that any other
application uses. To do this, simply

but think of it as converting an LPE

. path to a plain SVG path, and it
. makes more sense. Like any other
. Object to Path conversion this is a
. strictly one-way affair, so make
" sure you keep a backup of the file
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from just before the change, in
case you subsequently find you
need to modify your LPE
parameters after all.

That's enough behind-the-
scenes detail for now, let's press
on with another path effect! As

so let's start by drawing a simple
arrow shape.

~ ® -
: (‘
L ¥ L]

The path effect we'll look at
this time is “Bend”, so add that to
your path following the
instructions from the previous
instalment. As before, there's no
immediate change to your image,
but the LPE dialog has gained a
few controls at the bottom. Of
particular note is this quartet of
buttons:

N O B @

This arrangement of buttons
appears frequently in LPEs,

whenever an extra path is required -

as part of the input parameters. In

the case of the Bend effect, two
paths are required: the original

. skeleton path (the arrow shape, in
: this case), and a bend path whose
. shape dictates how the skeleton

. path should be distorted. These

. buttons are for managing the bend :
. path, as follows:
usual we'll need a path to work on, : :
.« The first button allows you to edit :
. the bend path directly on the

: canvas. This is the most commonly
. used of the four.

.« The second button lets you copy
. the bend path to the clipboard.

: From there you can paste it into

. another LPE, or even paste it

- directly into the canvas as a new

. path in its own right. These copies
: maintain no connection to the

. original bend path.

.« The third button is for pasting a

. path to use as the bend path. This
: could be one that you've copied

. from another LPE using button

: two, or it could be a path you've

. constructed elsewhere in your

: canvas. Again, there's no

. connection maintained to the

- original path.

.« The final button lets you linkto  :
. an existing path, rather than create :
. anew bend path. In this case there :
. is a live connection to the original

path, so any changes you make to
that are immediately reflected in

the LPE. I'll discuss this button in

~ more detail a little later.

directly over your skeleton path.

. This is the bend path, and you can
. manipulate it in the same way as

any other. Try dragging the path

- itself, or use the node handles, to
. distort its shape, noticing how the
. skeleton path is morphed in real-

. time to match your changes. You

: can also move the nodes

. themselves, in order to stretch,

: compress or rotate the skeleton
. path. If the bend path disappears - :
- usually due to a mis-click causing
. the skeleton path to become

- selected —just click on the first

: button of the quartet in the LPE
. dialog to make it reappear. With
. barely any effort the Bend path :
. effect can turn your straight arrow
© into a curved or sinuous shape that :
. would take a lot more time and :
: work to produce using normal path :
. editing techniques:
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But there's more! Your bend

. path doesn't have to be limited to

- a pair of end nodes connected by a
If you press the first button you P Y

should find that a straight green
. path appears on the canvas,

: curve. You can add extra nodes,

© turn them into corners, mix

. straight and curved sections, have

. the path double-back on itself, or

. even split it into several sub-paths.
. Admittedly, getting too complex

© with your bend path can lead to a

. degree of contortion that's hard to
: control, but the options are there

: for you to explore.

Using the second and third

: buttons you can copy and paste

. the bend path from one LPE to

. another, which can be handy if you
. want several skeleton paths all

. distorted in the same way. Each

. bend path will be an independent
. copy, though, so changes to one

" won't affect the others.
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Sometimes it's useful to have
multiple bend paths all linked to a
single “master” path, such that
changes to the shape of the
master are immediately reflected
in each individual LPE. The fourth
button allows you to achieve that
effect, but it's not without its
difficulties.

For this example I'm going to
use two different kinds of arrow,
and | want to apply the Bend LPE
to both of them such that they

follow the shape of the green path

at the bottom of the image.

< <«

N

The first step is to select the
green path and copy it to the
clipboard. As well as copying the
path data itself, Inkscape also
stores a reference to the original

object. Next | need to select one of :

the arrows, add the Bend LPE, and
click on the fourth button to use

the stored reference to define the
bend path. Clicking this button has

. two immediate effects: the arrow
- is distorted to match the bend

. path, as expected, and the arrow is :
. moved to the same location as the
. bend path — which is not what |

- wanted! If | add a Bend LPE to the
. second arrow and link that to the

. bend path, that also gets moved.

- I've got all the right shapes, but

: not necessarily in the right

. locations.

: ACtfFirst this might seem like a

. Fairly trivial problem. Just drag the :
. arrows back to where you want :
. them, right? Unfortunately that
. doesn't work — drag them away and :

. they'll spring right back to the :
. location of the bend path. Drag the :
. bend path away, and they both

- follow along after it. Being able to
. link to a common path seems a lot
. less useful if it means that your

. linked shapes all have to sit on top

of each other.

Fortunately there are a couple

of ways around this problem.
Inkscape has a setting hidden away

. in Edit > Preferences > Behaviour >
. Transforms labelled as “Store :

Transformation”, with options of

: Optimised or Preserved (it's in File :
. > Inkscape Preferences > :
: Transforms on 0.48). Use

. Optimised and you'll see the

. behaviour I've described above -

. LPE paths strongly bound to their
- linked bend path. Set it to

: Preserved, however, and you can

. move them around with impunity.
. Of course there's a trade-off:

. Optimised results in slightly

. smaller, more efficient files,

. whereas Preserved potentially

. stores additional data for any

. object that's been transformed,

: not just the ones that are causing
: us problems.

. extra data to just the problem

paths. It's a little counter-intuitive, Bend LPE are fairly simple. The

: Width spinbox lets you control the
. scaling of the skeleton path,

. perpendicular to the bend path.

- Play with it to see the effect. The

: but it does the job perfectly: just

. select your path and add a second
: Bend effect to it. You don't even

. have to modify the bend path -

- just adding the effect is enough to :
- let you drag your path around

- independently of the linked bend

path once more.
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Whichever approach you take,

- you should now have two separate,
. independently positioned arrows,

. both of which are linked to the

. shape of the master bend path.

: Modify that path and you'll see the
. arrows shape change accordingly.

- If you don't want to see the bend

. pathin your final design, simply

. hide it behind another object, set
: If you want to leave the setting : . . . ;
; .. . : its opacity to 0 (use View > Display
- as Optimised, there is a second : s . .
. ) : Mode > Outline to find it again) or
alternative which allows you toadd : . . .
: just move it onto a hidden layer.

The remaining controls for the

: “Width in units of length”
. checkbox has a slightly misleading
" title: “keep width proportional to
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length” would be a better name.
Check this, and the width of the
path is scaled as the length of the
bend path changes; leave it
unchecked to keep the width

unchanged regardless of the shape
of the bend path or the position of :
. object, so you can't subsequently

. edit the content if you find a

. mistake. Often a similar result can
. be obtained by drawing a separate
. bend path, then selecting both

. your text and path before using

: Text > Put on Path. You may need

the end nodes. The final checkbox
is quite self-explanatory: if you
wish to bend a path that's more
vertical than horizontal (e.g. an
upwards facing arrow), then check
this box, otherwise you'll be
distorting along the width of the
shape, rather than its length.

The Bend LPE is one that's well
suited for use with text, to
produce the sort of “Word Art”
effects so beloved of parish
newsletters in the 1990s. Because
LPEs won't work directly on a text
object, you first have to perform
the one-way conversion of your
text into a complex path. Using
Path > Object to Path will result in

a group of individual paths, one for
each letter. We really want a single :
path encompassing the whole text,

so it's easier to use Path >
Combine, which will convert your
text into paths, and combine them
into a single complex shape, all as
one operation. The final result will
be a group of one object, so you'll
probably want to ungroup as well.

From there you're free to add a
Bend effect and distort your text

as you would with any other path.

Before you race off to convert

your text into a path, however, it's

worth considering the downside:
the shape is no longer a text

to manually kern some of the
characters to get the right result

. (see part 11), but it has the distinct :
. advantage of keeping your text

. editable. In this image the red text
: was converted to a path and bent,

. the green is the same text put

: onto a copy of the bend path, and

. the blue is the same as the green,

. but with some manual kerning

. applied.

One noticeable difference

between the approaches is that
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the LPE distorts the shape of the
letters, whereas text-on-a-path
maintains their original shapes.

. Sometimes the distortion effect is
. desirable, in which case | can only
. recommend that you save a copy

. of the file just prior to converting
. to apath, in case you do need to

- edit it later.

Next time we'll move beyond

simple path bending and into the

. kind of Full-on distortions that can
turn some simple text into a 1970s
. album title, as we continue to look
at Inkscape's live path effects.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at

http://www.peppertop.com/
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% IncrediBuild
BEYOND ACCELERATION

HAVE YOU EVERTHOUGHT WHAT WOULD HAPPEN
IFYOU MAKE ALL YOUR DEVELOPMENT
PROCESSES RUN 10 OR 20 TIMES FASTER?

Slow builds, long running tests and scripts, compute intensive development
processes delay continuous delivery, leading to longer release cycles,

missed deadlines, broken builds, overworked develops, and insufficiently
tested software.

INCREDIBUILD ACCELERATES BUILDS,
COMPILATIONS, TESTING, AND ANY OTHER
DEVELOPMENT PROCESS

WE SPEED UP YOUR DEVELOPMENT LIFECYCLE

Once thought a reality of every development process, make slow builds a
thing of the past.

Increase your development productivity, accelerate your build lifecycle, and
enable truly Agile development.

Realize the premise of faster Continuous Delivery and get your Continuous

Integration to perform.

ACCELERATE LINUX AND
ANDROID DEVELOPMENT

Being able to directly visually audit the build
process to look for bottlenecks whilst
reducing execution time is wonderful.

Richard Trotter
Geolerie
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Are you still waiting for your build to finish?

Stop waiting. Start running. Get IncrediBuild for Linux. Download it at www.incredibuild.com




ARDUINO

Written by Ronnie Tucker

IDE 1.6.6

S\

he first week in November

brought an update to the
Arduino IDE. The upgrade to 1.6.6
brings in an impressive 720+ bug
fixes.

: there are also many comments

© that 1.6.6 has some seriously bad,
and some say critical, bugs.
BEST NEw FEATURE So, if you REALLY want to
There are several new features
(that I'll probably never use) such
as a command-line tool, a new
modular architecture, lots of bug

fixes, etc, etc, but for me it's all
about:

© it's currently not without its risks.

Serial Plotter - Now we're
talking! This | can use. By using a

_ i 3Eveid setup()
command like: : 4 -,._;ri:dl-_.__-_-.;gﬁm]:
: fille [!'Serial);
: }
Serial.println(analogRead (A0) :
: void loop() {
) : for (double i = -1.0: i <=1.0; i =i + 0.08) {
: Serial.println{sin(i));
. . . Y delay (18) ;
you can view real-time datain a TR
. . . : for (double i = 1.0; = 0 -
nicer way than just having numbers : iy o e S
: T delay (10);
Flying past. 1)

}

Having data output to the serial :
monitor is really handy, but being
able to see it in a more visual way
is a great new addition!

UH oH!

Having said nice things about it, :
. bought a RepRap Fisher Delta 3D
. floating around the Internet saying :
. powered. It uses a board based on
: the Arduino Due. So, in the next

: month or two, expect the Arduino
: : section to cover 3D printing. I'm

: update: go for it, but be aware that :
. video/photography of the build,
. and probably end up writing a

: review of it too.

0.08) {

Full circle magazine #103 @ 33

In other Arduino news: | just

printer kit which is sort of Arduino

e
(=)
Ronnie is the founder and (still!)
editor of Full Circle. He's a part-time

arts and crafts sort of guy, and now
an Arduino tinkerer.

hoping to do some time-lapse

JdevfttyACMO (Arduine Zero (Programming Port))

9600 baud v

ﬂ
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CHROME CULT

Written by S. J. Webb

aimed to provide an encryption
how-to using a Chrome browser
and the app store. However the

recent news by Google caused this :
impromptu opinion piece. Chrome : independently: Android and

: Chrome. Android is the leading

. mobile OS, with a strong app

. developer presence. However it is
: plagued by being insecure, and

: lacks proper and timely security

: patches. Chrome is extremely

: secure using native SSD

© encryption, web app sandboxing,
: and security updates every 6

: weeks. Yet Chrome has a much

© weaker app store developer

OS and Android are being merged
into a new OS. The beta OS will
premiere in 2016 and the Full
hybrid of mobile and cloud OS will
emerge. It will be ready for
consumers in 2017. There are no
details about the name for this
new OS or hardware associated
with it.

Google has given conflicting

reports of maintaining the Chrome
- security of Chrome OS and the

: Android App Store together,

: Google will get scale and

: efficiency. They will have more

: users on the Google Ecosphere by
. pushing this new hybrid OS.

OS for the current Chromebook
base. In an ideal world the new
hybrid OS will run on the
Chromebooks without fault. If not,
| will be using Crouton for Ubuntu
Mate.

People are split on this decision. :
. create an Android Chromebook
© Prototype. It is called the Pixel C. It :
© offers the tablet features, but with
an optional keyboard. | believe this
evolution of the Google Ecosphere. ;| will be the first computer that will :
: sport the hybrid OS.

They believe Google is killing off
the Chromebook, despite the
continued growth and popularity.
Others believe it is a natural

Google has killed off unpopular
items in the past. However the

Chrome OS is too popular to
. completely kill off.

Let's review Google's two OSes

presence. Ideally, by merging the

Google has already started to

The Pixel Cis priced around

© $500. However it will come with
: 3GB RAM, Nvidia Quadcore

. processor, Maxwell GPU and a :
© 32GB or 64 GB SSD. The Pixel is still :
© Wi-Fi dependent. This device is :
- following the trend of tablets :
: sales, since desktop computers are
- declining. This device will still make :
© Google relevant as consumer :
. trends change.

: After using my Chromebook for :
© the last Few months, | would :
: recommend it as a backup

- computer to a Linux distro or :
: MacBook. | would recommend my :
. Chromebook as the main computer :
© over any Microsoft OS. Idonot
: mind living in the cloud as long as
- limitations are known. I suspecta
. Chromebook-like device will be my :
- kid's first laptop. I learn to adapt to
. my Chromebook. Undoubtedly | :
- will learn to adapt to this new OS
. coming out in 2017. For the time
being, Chrome Cult will continue to :

review the cloud computing
experience.
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Privacy

3=)

SJ Webb is a Linux Hobbyist and
Research Coordinator. He enjoys
fishing, hot rodding, and spending
time with his kids and wife. He
thanks Mike Ferarri for his
mentorship.
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HOW-TO

Written by Ronnie Tucker

GUIDELINES

he single rule for an article is

that it must somehow be
linked to Ubuntu or one of the
many derivatives of Ubuntu

RULES

* There is no word limit for articles, please Follow these guidelines :

but be advised that long articles
may be split across several issues.

* For advice, please refer to the
Official Full Circle Style Guide:
http://url.fullcirclemagazine.org/7

 Write your article in whichever
software you choose, | would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND
GRAMMAR CHECK IT!

* In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

. document.

* Images should be JPG, no wider
: than 800 pixels, and use low
. compression.

(Kubuntu, Xubuntu, Lubuntu, etc). : * Do not use tables or any type of

- bold or italic formatting.

If you are writing a review,

When you are ready to submit

your article please email it to:
. articles@fullcirclemagazine.org

. TRANSLATIONS

If you would like to translate

. Full Circle into your native

- language please send an emailto
: ronnie@fullcirclemagazine.org and |
. we will either put you in touch with :
. an existing team, or give you :
- access to the raw text to translate
. from. With a completed PDF, you

- will be able to upload your file to

- the main Full Circle site.
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Write For Full Circle Magazine

REVIEWS

GAMES/APPLICATIONS
When reviewing games/applications please state clearly:

title of the game

« who makes the game

e isit free, or a paid download?

» where to get it from (give download/homepage URL)
* is it Linux native, or did you use Wine?

 your marks out of five

« a summary with positive and negative points

HARDWARE
When reviewing hardware please state clearly:

» make and model of the hardware

» what category would you put this hardware into?

« any glitches that you may have had while using the hardware?
* easy to get the hardware working in Linux?

+ did you have to use Windows drivers?

» marks out of five

« a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
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LINUX'LAB

Written by Charles McColm

R ick Jenkins is a volunteer with
The Working Centre’s
Computer Recycling Project.
Besides being a good computer
technician he's also a very skilled
artist, 3D modeller and all around
tinkerer.

Rick’s passion for tinkering has
in the past led him to create a
number of cosplay props ranging
from a full length steampunk
jacket to a steampunk gun that
featured a light-by-light power-up
effect and full sound effects. He's
also a long time open source user
who started out with an early

release of Red Hat Linux. Currently

Rick uses Arch Linux on his home
system, but he chose to install
Ubuntu on the computer for his

\ latest project: the Vaster Mini3 3D
- printer outlined on
© Instructables.com: :
: http://www.instructables.com/id/B

. uilding-a-3D-Printer-Under-299/

Ubuntu made sense for the

: computer running the 3D printer

. because there were already

© packages for the makerbot

: software. Rick uses Slic3r, which

. does the same as the makerbot

: software, and Blender to build the
. models.

be models cheap enough that

. most people will have at least one
: 3D printer in their home. Part of

. the impetus for building (over

. buying) the 3D printer came from
. the availability of local resources.
. InKitchener, Ontario, the local

. maker group, Kwartzlab, has a

. large laser cutter and several 3D

- printers. The local library also has
. several 3D printers. The other itch
. to build (over buy) came from

Full circle magazine #103 @ 37

Building A 3D Printer;

3D printers have been available : Rick’s tinkerer nature.
. for a few years now and Rick :
: predicts that within 5 years there’ll :
. from instructables.com which has

: links to some of the sources for

. the hardware, the motors and the
: Arduino. The nuts and bolts were

. bought at Spaenaur and the metal
: rods and some of the additional

. components were recovered from
. old inkjet printers from the

. Computer Recycling Project.

The design for the printer came

The greatest challenge building

: the printer was collecting all the

. information to build it. The initial
. research before cutting out the

: first part with the laser cutter was
: significant. Knowing why he

. needed to use each part was

: important to ensure proper

. operation: making sure the
stepper motors are moving the

. right distance, making sure there’s
. no print slide (instead of getting a
: cube, getting a parallelogram -

: misalignment).

Rick chose to build the Vaster

Mini3 over other instructable
: designs, partly because of the way
" it looked and partly because it was
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LINUXLAB

described as an under $300 make
your own 3D printer. In fact the
costs actually ended up around
$140. The most expensive parts
were the Arduino control kit and
the nema 17 motors. Rick had
extracted several motors from
inkjet printers, but because of

motors.

printer_front.pngThe structure
of the 3D printer is mostly
complete after 1 2 months
invested. Part of the time
investment was due to limited
access to the laser cutter, sourcing
local shops, and waiting for
ordered components to arrive. All
that's left now is waiting for the

motors to arrive. Once parts are in
it should only take a couple of days

to do the initial complete
assembly, do the initial test prints
and recalibration.

With the structure assembled, a
good part of the 3D printer is built,

but there are still several things
that could go wrong. The Arduino

may not take the initial flashing of

its BIOS to tell it that it's a 3d
printer. The Slic3r software may
provide standardized gcode that
the Arduino may not interpret

correctly. One of the Nema 17
motors may not work right. The

: extruder assembly could jam and

. malfunction. The motor feeder

: may feed at the wrong speed

. compared to the heater head. The
: thermistor might misinterpret the
: temperature. This is why Rick
where the mounting holes were on
the design, it required the nema 17 :

spent so much time on initial
research.

On the computer side of things

Radeon HD6530D graphics. It
handles pretty much any Blender

. design Rick throws at it.

For anyone thinking about

resource. Online resources are

person, if you have the machine in

hand, someone who has built a
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machine can look at it and point

~out anything wrong with it.

Rick plans to print replacement

: components for computers and
© building a 3D printer, Rick suggests :
© connecting to a source of

: information, such as 3d printing
© groups, so you can talk to other :
. people who have gone through the :
: process of either buying or

: © building a 3d printer. It's the best
© Rick started with an old Pentium 4, :
: but Found that Blender choked too
: much. The Computer Recycling

: Project had recently had several

. generous donors so he ended up

: reclaiming an AMD Quad Core A6-
© 3620 APU system with 8GB RAM, a :
: 1TB hard drive and the onboard

laptops as well as special personal

projects like a lightsabre, and
. other costume accessories.

People can contact Rick on

. Googleplus: gaelfling@gmail.com

© Kwartzlab:
great but they don’t always tell the :
© full story. In person you get
© immediate responses. Online there :
© can be a lot of time wasted trying
© to get the right answer. Also in

http://www.kwartzlab.ca/

© Vaster Mini3 printer:

http://www.instructables.com/id/B

: uilding-a-3D-Printer-Under-299/

© Ewaste $60 printer:

: http://www.instructables.com/id/e
: Waste-60-3DPrinter/step2/Step-2-
. Preparing-Motors/

© Slic3r: http://slic3r.org/

. Blender: http://www.blender.org/

Charles is the author of Instant
XBMC, and the project manager of a
not-for-profit computer reuse
project. When not building PCs,
removing malware, and encouraging
people to use GNU/Linux, Charles
has a blog at charlesmccolm.com.
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UBUNTU PHONES

\

Written by Ronnie Tucker

BQ AQUARIS UBUNTU
PHONE RELEASED IN RussIA

fter previous successful
launches of the Aquaris E4.5

and E5 HD Ubuntu Editions, BQ will :

now release Ubuntu Phones in
Russia. Devices will be available for
purchase through a host of local
distributors such as Ozon.ru

. (http://www.ozon.ru/context/detai :
© 1/id/34629381/). The Aquaris E5 HD':
© Ubuntu Edition will be sold at a
© price of 15,499 with the soon to be :
: launched Aquaris E4.5 at a price of :
©12,499. :

Russia continues to be an

: more: :
: https://insights.ubuntu.com/2015/ :
: 11/17/bg-aquaris-ubuntu-edition-
: phones-land-in-russia/

OTA-8

This list is only a highlight of

the few changes available in this
: update. Please check the detailed
changes for all the changes

included in this OTA.

IMPORTANT FEATURES

* New 15.04.2 framework, UITK
offering new PageHeader

: component

* New twitter scope, new book
aggregator scope

: «Sound controls in the sound
© indicator (Play, Pause)

: : « QtPurchasing based in-app-
: important market for Ubuntu with :
© astrong and fervid fan-base and
. developer community. Demand has:
: also increased in the region since
: the initial launch of the devices

© back in February this year.

purchases

- WEBBROWSER:

: « Media access permissions for
© sites

.« Top level bookmarks view

: « Thumbnails and grid view for Top :
© Sites page

* Buteo used for contact sync

: « Location service velocity and
. heading information

: « OTA version numbering now
© visible in system-settings (e.g.
: OTA-8)

.« Completely re-designed weather- :
: app

. « Porting core-applications to UITK
1.3

. BUGFIXES

As we know, each release

" includes a huge number of bugs -
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. some for previous issues and some
. for new regressions introduced in-
. between. To see the overall list of

. what issues got fixed, please check
. the detailed changes below. The

: interesting ones are as follows:

. » Performance fixes for various

: components (e.g. messaging-app,

. SDK components)

.+ Fixes to location accuracy

. *»Reduced power use when there is
: no network connection

.+ Call ringtone will play on

. speakers with headphones

. connected

.+ Fixes to reduce some of the Ul

. hangs due to dbus traffic

...and much much more.

. DETAILED CHANGES

Commitlog:

http://people.canonical.com/~lzem

. czak/landing-team/ota/ota-
: 8.commitlog

© Milestone bug list:
https://launchpad.net/canonical-
i devices-system-

. image/+milestone/ww46-2015

n contents ©


https://insights.ubuntu.com/2015/11/17/bq-aquaris-ubuntu-edition-phones-land-in-russia/
http://people.canonical.com/~lzemczak/landing-team/ota/ota-8.commitlog
https://launchpad.net/canonical-devices-system-image/+milestone/ww46-2015

This year avoid the high street chaos and shop from the safety of your home.

Put the kettle on, relax and visit ebuyer.com for the best deals on laptops, TVs
and electricals. Is Black Friday really worth a black eye?

FIND OUR EARLIEST DEALS ON NOVEMBER



BOOK REVIEW

Written by Lucas Westermann

THE BOOK OF

GNS3

BuiLe WIRTUAL NETWORK LABS usiNG
CIRCO, JUNIFER, AND MORE

July 2015, 272 pp.
ISBN: 978-1-59327-554-9

https://www.nostarch.com/gns3

R ecently, | received a review
Jason C. Neumann from No Starch

and testing out as much of the
content as possible, I'm ready to
present my review. But before we
get to the book itself, let's answer
a question some readers will
probably have.

WHAT Is GNS3?

GNS3 stands for Graphical

- Network Simulator-3, and is a tool
. to simulate networks (including

. virtualized and physical hardware). :
- Itis commonly used for testing :
. networks before deployment, or
J : for certification exams.

. ABOUT THE Book

The book itself goes into detail

- as to what hardware/software the
. program can handle, as well as why :
© you may want to use it. It's geared
. largely towards networking

. engineers, or students studying

. networking in some fashion.

. However, if you're interested in

- dabbling, or want to study up on

GNS3 for work on your own time,
copy of “The Book of GNS3” by :

this book will probably Ffulfill that

need. While the book offers a
Press. After having read throughiit, :

decent index, | have a hard time

seeing it Fulfill the role of a quick-
- and-easy reference book. S0 if you : can be identified without issue.
: don’t want to follow along step-by- :
- step, or are looking more for a

: cookbook-style book, you may

want to look for alternatives.

The Book OF GNS3

. However, this is not a point against
the book - it doesn’t market itself

. as a cookbook, but as a guide to

. GNS3. Which it very much is.

. STYLE

Jason C. Neumann manages to

. write in a way that, while filled

. with information, is still easy to
. understand, and often amusing.
. The book also contains a large

. number of screenshots, which help
. the reader to follow the steps :
: accurately. They are often placed

: in such a way that no paragraph is
. cut off before/after the image,

. which helps the flow of text. If you
. don't feel you need the images,

. skipping over them should be a

. simple enough matter, without :
. abrupt line breaks in paragraphs or :
. sentences.

The formatting used for

commands and text ensure they
. are easily read, and all characters

. Additionally, any changes to files,
or important segments, are ;
 marked in bold. Combined with the :

screenshots, the formatting is
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. often enough to head off or solve

: any issues you may run into. Not

- only this, but the author sticks to

- his formatting system in the actual
. prose of the book as well. This

. means any buttons, menu items or
. other important words, are also

. marked in bold. So if you're

. skimming through a page trying to
. find where you went wrong, or

- where that menu item disappeared
. to, you'll be able to easily catch it

: on the page.

. INFORMATION

The book is OS-agnostic - it

covers installing GNS3 in Ubuntu,

. Windows and Mac OS X, as well as
. compiling it from source. It covers
. all operating systems wherever

there may be differences, and

since large parts of the book focus
. on virtualized hardware, it doesn'’t
feel like you're skipping paragraph
. after paragraph if you're using
Linux instead of Windows.

The book covers everything

from installing and setting up

GNS3, to physical and virtualized
hardware, and on to some projects
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BOOK REVIEW

“for a rainy day”. The author
focuses mainly on Cisco and

Juniper devices, but as they appear :
: exam. So if your goal is a

. certification, you will need to

. combine this book with the other
. aspects of your particular exam.

to be the most common choices, it
seems like a good decision.

WRAP-UP

While this book is by no means
an exhaustive list of everything
that is possible with GNS3, it is an
excellent introduction, or a
supporting book for anyone
involved in a certification
exam/school course where GNS3
and Cisco/Juniper devices are the
focus. If you're looking for a
cookbook or dry reference book
for quick and easy answers to
questions, you will most likely
need to keep looking (although |
do recommend keeping it on the
list, just in case).

If you're trying to expand your
horizons on your own (for work or
for yourself), this book should be
able to guide you through GNS3
and give you enough information
to do so. However, you may need
to do a bit of googling, or
experiment with GNS3 on your
own, depending on your current
skill level and end goals. | should
also note that this is not a Cisco

networking certification study
guide, simply a book that covers
some aspects that may arise in the

While this book isn’t an

. exhaustive resource, and won't suit :
. everyone's needs, it does achieve
. exactly what it sets out to be: an

. introductory guide to GNS3.

P

=

Lucas has learned all he knows from
repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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MY STORY

Written by AuntieE

B ecause Ronnie had reported
the successful recovery of
over 500 photos with Photorec
after the Great Crash of his hard
drive in 2014, | offered to try to

friend in the States whose
computer expert had said it would
be impossible to retrieve
anything... and yet it contained
pictures that were invaluable to
her. She mailed me the drive and,
after it had spent the night in the
refrigerator (NOT the freezer) |
went to work.

Windows 10 on a 4-year-old
Toshiba laptop kept offering to
format the two partitions (one
Windows RE-Store, the other,
apparently, system and data, in a
roughly 10-90% partition setup of
the 500 Go), but would then say
partitioning was impossible. The
disk utility of Lubuntu 14.04 (on a

Samsung Netbook that dates back

to 2007) didn’t even find the disk.
With nothing to lose, | googled
testdisk and went to the official
download page at

http://www.cgsecurity.org/wiki/Te :

stDisk_Download where the latest

. version is 7.0. 1 downloaded the

. testdisk-7.0.linux26.tar.bz2 and

. copied it to my home folder on the
: Samsung. | then used the terminal
: to unzip it with sudo tar xvf
recuperate pictures on the HD of a testdisk-7.0.linux26.tar.bz2 which
. created a folder called testdisk-7.0, :
. inside of which, among other

: things, was testdisk_static and

photorec_static.

OK, | thought I'd start with

 testdisk and both partitions came
: up green, although the drive still
. wasn't recognized by the disk

© utility. (I admit that I didn’t go into
. the log or try to understand

: anything...) Instead, | then went

. directly to photorec (everything is
. done with the command line) : cd

. testdisk-7.0, then sudo

. ./photorec_static. | got a page

. asking me which drive | wanted to
: recuperate things from : | chose

. the Windows one first, but, after

- about six hours, | stopped that and :
. started over. :

digital

: | won’t bore you with my
: umpteen tries that lasted

igital picture recovery

& http://www.cg security.cﬂ :
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: overnight and beyond (until

: everything got too hot to work),
: BUT I finally realized that I could
© use the options.

So: cd testdisk-7.0, sudo

. ./photorec_static, password, new

: page, select partition, new page,

© type of partition selected (in my

© case FAT, etc.), new page, where do

you want to save the recuperated

. files? It suggests doing it within
: the testdisk folder, so | hit c (to
show that that was correct).

At some point, at the bottom of

. the page where the first option

. (Proceed) is automatically

. selected, there is the possibility to
. choose Options (arrow key + Enter)
: and, there, to choose NOT to

: disable Brute Force (in other words
: to enable it), Enter. Then you can

: move to the File Opt where you

: can deselect everything by hitting

: b (I think, I'm doing this from

: memory because the Netbook

: refuses to search the hard drive

. any further...). All the X's in the

. boxes next to file types disappear

and you can navigate down the list
to choose what you really want, in
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MY STORY

my case JPG and DOC + Enter.
THEN you can return to Proceed
(with the left arrow key) and press
enter.

With just two Ffile types
selected, the search was much
faster: 465 hours instead of 1654,
or something else unbelievable,
were announced. Any time you

do is press enter because STOP is
highlighted, and go through the
rigamarole of Do you really want
to Stop, etc. The best part is that
the next time you use photorec,
you will be asked whether you
want to resume the search you
already started. Y + Enter. Select

where you want the recovered files
to be stored (c for correct). And off :

it goes again...

What do you actually recover? If

you start with all the Ffile types,
you'll find yourself with 50 GB or
so of things in several different
folders named recup_dir.1,
through recup_dir.34, etc.

depending on how many times you

try things. Most of the .doc files |
recovered were system files (one
even weighed in at 480 MB - no
hope at all of opening it with
LibreOffice), several were .db,
which | thought might be

genealogy tables, but when I tried
to open them in both Linux and

. Windows, | got a message they

. were system files. Unfortunately,
. at least half or more of the .jpg

. files were in fact pictures from ads, :
. carpets, pants, dresses, etc., of ;
. absolutely no interest. BUT 190

. bona fide photos were recovered,
- although some of them are

want to Stop the search, all have to :

doubles.

As to the huge recup_dir

folders, there seemed to be no
. way to delete them. Even sudo
- nautilus wouldn’t let me get rid of

them. Finally (thanks to something

| read in Full Circle recently), | tried

- sudo su and nautilus and, at last |
. could erase them and recover

: some space in my Netbook’s hard

drive.

© Tosumitallup, | guess that the :
- keys to success with Photorec are
. obstinance, patience and

. discernment. Tomorrow, I'm

- mailing my friend a full CD of her

- lost pictures and that is what |

. would call a triumph: the triumph
. of Lubuntu, photorec, and sheer

. persistence.

i PhotoRec

5.9 - LA .-.-.-z}/_a.-?%/ﬂ-’,?f//%f%’.|

Fle Edit View Terminal Tabs Help

357 files fTound

chievement 8hBBml9
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PERSONAL FINANCES

R e: personal finance
applications: For years, | have

always used Gnucash for all my

banking needs. It allows you to go
to your banking and "download to

debits/credits to your Gnucash
account. Setup is not difficult.

You can print reports for assets

and liabilities, budget, business
reports, income expenses and
more.

Tom

Ronnie says: Tom has kindly written
up a quick intro to Gnucash that will

. MuLTiBoOT WITH UEFI

be featured in a future issue of FCM.
Stay tuned!

DisTRO HOPPING

have been using Linux for many

years, starting with Mandrake
over 15 years ago. Now | use Linux
Mint Cinnamon as my main distro,

based distro which would give me

LETTERS

the same stability. | have used

. Arch-based distros like Manjaro

. and KaOS, Debian-based distros,

. and RPM-based distros, but they

. all let me down at some time or

. other. Almost in desperation, | am
. now using Kubuntu 15.10, which
Quicken" which will download bank . seems pretty stable and gives me
- all the apps that I require, plus

: enough customisation to get my

. screen looking the way | want it.

It seems that Ubuntu-based

. distros are still the best and most
. reliable Linux distros.

Bernie Victor

I read this excellent article by
. 1 Frank Dennisen in FCM#102, but :
. would like to add one word of :
© warning, based on my own
. experience.

Frank advises to run fstrim

during boot-up by editing

but have been trying to find a KDE- : /etc/rc.local. I normally schedule

fstrim with cron to a time when |

. but I think it is necessary to let

. Fstrim finish before creating any
- disk activity. Unfortunately there is :
. no indication of when it finishes
- and it can take some time; six

: minutes in my case.

If you would like to submit a letter For publication, compliment

or complaint, please email it to: letters@fullcirclemagazine.org.
PLEASE NOTE: some letters may be edited for space.

. know | will not be using the
- machine.

| tried Frank's suggestion but

. Forgot Fstrim was running next
. time | rebooted. | then tried to :
- suspend and the computer ignored :
. this for a while and then wentto a :
. black screen. | hit Enter and the

. screen repainted and then

. suspended ok. When | tried to

. wake-up the machine, I got a

. terminal with a lot of messages

. about memory locations being

. unusable. A reboot fixed the

. problem.

Frank's suggestion will work ok

Michael
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Join us on: *

w 900.gl/FRTMI
o5

@3 facebook.com/fullcircle
magazine

E twitter.com/#!/fullcirclemag

in

linkedin.com/company/full-
circle-magazine

ubuntuforums.org/forum
display.php?f=270

FuLL CircLE NEEDS You!
A Without reader input

- Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small

things like letters and desktop
screens help fill the magazine.

See the article Writing For Full
Circle in this issue to read our
basic guidelines.

Have a look at the last page of
any issue to get the details of
where to send your
contributions.
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INTERVIEW ' WITH

Conducted by Ronnie Tucker

FCM: IF I may be so bold as to ask: :
. been trained to help on a wide
. range of common issues which are
: Linux specific.

how many Ubuntu PCs and
laptops have you sold?

eBuyer: Sorry, | can't give out
direct sales data, but we are
delighted with the uptake of
Ubuntu and its sales as it has
exceeded our initial predictions.

The strong figures have meant
we can plan ahead to next year,
opening up for more
manufacturers.

How many (in
number/percentage) were
returned?

Again can’'t hand out sales data but

our returns have been marginally
lower on Ubuntu Laptops
compared to the Window 8
equivalentin 2015.

Do you provide support for your

Ubuntu machines, or do you point

your buyers elsewhere for help?

The manufacturers (HP for the

current range of laptops) cover the 5

main support issues, however our

in-house tech support teams have

Would you consider selling :
: Ubuntu phones (from BQ/Meizu)? :

: We have been looking at the

. options for importing an Ubuntu

: phone into the UK, we just need to
. find the right distributor and price
© structure.

We've already had a lot of

interest in the BQ model from a
: number of customers, so it's now

HPF 255 G3 Quad Core

AMDO
3

HPF 355 G3 Quad Core

A
Partrer AB

down to working on a good price
: and partner... watch this space.

Do you ship to the USA/Canada,
: or outside of the UK/Europe?

Unfortunately not at the moment,

we deliver to only the UK.

I notice most desktop PCs come
: with a DVD. Can | ask why Ubuntu
. isn't pre-installed?

. Ubuntu is pre-installed on all the

. laptops we stock. However due to
: the current manufacturers we use
. for the desktops, it comes as a

. simple DVD install. The next batch

Laptops Deskiops

Featured Products

HF 455 G3 Quad Core

AMDQ\
CEE
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we stock will likely come as a
. standard pre-install.

Why do some machines (laptops?)
: seem to come with Ubuntu 12.04?

: Ubuntu 12.04 was simply the stock
: OS on the batch of HP G3 laptops

: we brought in. However, most

. people upgrade to the latest

: edition of Ubuntu or sometimes

: shift across to a different distro

. like Mint.

What gave you the idea to start
: using Ubuntu?

: We used to sell a lot of products

© with no operating system on

: board, so we looked into why and
: found that there was a massive

: community for Linux systems,

. specifically Ubuntu. From that, we
© wanted to make it easier for

© customers, so we created a line of
: pre-installed models that we

. hoped would take off, and it did -
: as hardly any retailers in the UK

: offer Ubuntu pre-installed.

Do you have a favourite Flavour

of Ubuntu?
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INTERVIEW WITH EBUYER

Personally, | prefer the standard
Ubuntu package as it feels closer
to a traditional OS - but with the
Linux freedom, I'm a bit of newbie
in the Linux world, so it helps
having something that is tangible
to my old OS habits.

From our customer’s
standpoint, we've actually had a
lot of comment and questions
about Lubuntu due to its
lightweight nature and speed. I'd
be inclined to say that Lubuntu will :
do well over the coming year.

Where do most Ubuntu buyers
come from?

A big proportion are IT buyers, as
you can imagine, as well as a
number of enthusiasts. Next to

that, and possibly more :
surprisingly, a number of the older :
generation seem to look at Ubuntu :
— we think because of the costing
and the easy-to-use nature of the
OS.

Do you need to give more, or less,
support to Ubuntu buyers? '

It's difficult to manage in terms of
support because, currently, the
pool of customers is still small

(comparatively). I, like we hope,
Ubuntu sales pick up across a

. number of lines, we'd love to add
: more support.

Have you had any hardware :
: challenges in putting together an :
. Ubuntu PC/laptop?

. Some manufactures have very

. strong ties with Microsoft, as you

. can imagine, so it's sometimes

: tough to get Ubuntu pre-installed.
. However, the companies we have

: spoken to about future ventures

. have been very open after seeing

. the uptake we had.

Cbuyer.com
 Free delivery on orders over £45.99°

Gookiss help us delver e Bagl saparance on o

Ubuntu Desktop PCs

Compuling = Slorage  Components  Peripherals | Saollware | TV & Enlatainmeant

ur wekahs, By using our webals, you agres 1o sur use of cookisg

Do you plan on having more
powerful Ubuntu machines

The overriding feedback on our

Customer Services

Ity Account

Login / Sign up

Your
Basket

Basket is empty
Order up to 11pm for next day delivery*

Business  Cloarance  Visl Businass Site

Oflice Supplias
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same jump this time - it just

depends on the manufacturer
. available? Or would you do, say, a :
. Lubuntu/Xubuntu range of :
: machines?

supplying the units.

| don't think we will move to

. Lubuntu/Xubuntu just yet; Ubuntu
The next batch of Ubuntu-installed :
. machines will likely be the next
. generation, so yes they will be

. more powerful.

still has a long way to go, when it

. comes to popularity with a wider
- audience.

. How about custom configurations
: . with Ubuntu?

. first stock of Ubuntu (in 2014) was
. “great to see Ubuntu, but we need
. amore powerful laptop”. So, in

: 2015 we came in with a more

. aggressive processor and higher

. RAM. We'll likely try and make the

: We don't really look to do custom
modification of any machines, so
. it's unlikely we would do it for

. Ubuntu.

. Do you use Ubuntu/Linux in the
. Ebuyer offices?

. We've got quite a range of OSes

. here in the office. Our IT dev team
. are the biggest consumers. As you
. can imagine, they use a mixture of
. Linux distros, the most popular are
© Mint, Ubuntu and Debian.

. Marketing also has a couple of

: Ubuntu machines, but the rest of
the company is Windows-based.

. eBuyer: http://www.ebuyer.com
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Compiled by Gord Campbell

GParted Edit View Device Partition Help
A % |~ | 0B = « | idewisdb (931.51 GiEj *| |
| N
IdevisdbS
BE5.29 GiB
Fartition File System  Label Size Used Unused Flags
fdevrsdb | nitfs WINRE_DRV 100000 MB 29525 MiB 704.75 MIB  hidden, diag
Idevrsdb2 B fat3z SYSTEM_DRV 260.00 MIB 32.55 MiB 22745 MiB boot, hidden
tdevrsdb3 B fat3z LRS_ESP 100000 MiB 501.04 MiB 49E.96 MIB hidden
sdevisdbd 2] [l unknown 12E.00 MiB - — mafires
IdevisdbS ntfs Windows8_05 889.29 GiB 135.58 GiB T749.71 GiEB msfidata
Idevisdbé 2 ntfs LENOWVG 25.00 GiB 69.77 MiB 24.93 GiB msftdata
Idevisdb? ntfs PBR_DRV 14.89 GiB 11.55 GiB 335GiE hidden, diag

Q | am in the process of
installing Ubuntu but the

Windows 10 dual-boot config. Is it
: possible to triple boot with Tails?

Is there any way to figure out
which partitions can safely be
deleted? I've included a screen
capture (above) of the partitions.

(Thanks to SeijiSenseiin the

Ubuntu Forums) Rather than
deleting partitions, I'd use the
Windows disk manager (Control
Panel > Computer Management >
Disk Management) to shrink the
Windows partition then give the
newly freed space to Linux during
installation.

Tails but I would like to keep

(Thanks to DK71993 and
Bucky Ballin the Ubuntu

. Forums) Tails is supposed to be
. used in a live environment. It is
. supposed to run in RAM and delete :
all information when the computer : address for the 192.168.1.0/24
. is powered down. Otherwise,

. considering distros that are

. intended for installation on a hard

. drive, yes, you can triple-boot

without issue. You just need free

If you have a Linux question, email it to: misc@fullcirclemagazine.org, and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

/devisth-GParted ~ . .| space onthe drive to create a

. partition and install to it.

Q During boot up, | got this

error message:

USB 2/3 device descriptor
read64, error -110

It was repeated two more

: times, then there were some other )
: : page and look at tutorials on the

i error messages. : . .
: . netasit's a big area.

This sounds crazy, but it
works. Shutdown your

| am very, very eager to install ;| COMPUter, unplug it for five
5 Q e | : minutes, then plug it back in and

. start it up.

My vortexbox server is
unreachable. Its IP address is

: 192.168.1.255

(Thanks to SeijiSenseiin the
Ubuntu Forums)

5 192.168.1.255 is the "broadcast"

: network. Both 192.168.1.0 and

: 192.168.1.255 cannot be assigned
: to hosts. Give the server a

. different address.
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Q | want to limit how much
Internet bandwidth any one
: usercan have.

(Thanks to matt_symes in the
Ubuntu Forums) You can do

traffic shaping with the command:
© ke

You'll want to read the man

. TOP QUESTIONS AT
. ASKUBUNTU

* How important is the sudo
. password?
: http://go0.9l/8NxLe6

* How to create a bootable .iso file
. from Ubuntu Live USB?
. http://goo.g9l/FRsgmu

* Delete all files except specified
. files/folders using command-line?
: http://go0.9l/S1LCVG

* Get all image files with wget
" http://go0.gl/OVLx4n
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Q&A

* Reinstall base Ubuntu without
formatting or removing manually
installed packages
http://g00.gl/RSQWrb

* Will Ubuntu 16.04 LTS server still
use dpkg?
http://goo.gl/mON1J4

* |s Linux getting less or more
secure?
http://goo.gl/EOAUC6

* 15.04 is available to update to.
Will I lose my data?
http://qoo.gl/81z4w?2

* No version of Ubuntu can be
installed with any 6th generation
Intel processor
http://qgoo.gl/NXEXaR

TiPs AND TECHNIQUES
CLEANUP!

his has little to do with Linux,
but | hope it's still interesting.

My "high-performance desktop"

computer is several years old. In

recent months, it has overheated if
" and memory. Not cheap.

asked to do anything mildly

computational. Even playing a
Youtube video was enough to

: cause a problem.

| could tell this, because Conky,

. combined with Im-sensors and hdd-:
. temp, displays all the :
. temperatures all the time. The
. computer has a "production” :
. partition and a "test" partition, and :
. they each have Conky installed to
. tell me what | want to know.

Eventually, | broke down and

. addressed the problem. Open the
. case, take the CPU heatsink and

: fan out, and give them a good

. cleaning. | also noticed that the

. "thermal paste," which connects

. the CPU to the heat sink, had

. broken down. New thermal paste,
. install the heatsink and fan again,
: button up the case, and all is well.

. Thisis not ajob for the faint-of- :
. heart! If you are concerned about
. tackling it, take your computerto a :
. trusted tech, and be preparedto
. pay a reasonable service fee. $100
. is not too much. Why? Because :
. even the most competent service
person will occasionally have a slip
. of the fingers, and now we're :

talking a new motherboard, CPU

In my specific case, it worked
beautifully. My CPU now idles at

. the same temperature as me, and
. even when rendering video, gets

. nowhere close to "too hot." Once
: again, | have a "high-performance”
. computer.

Aside: in my test partition, |
upgraded Xubuntu 15.04 to 15.10,

. and it went flawlessly. That's
. where | am writing this column.

P

=

Gord had a long career in the
computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 15-person accounting firm in
downtown Toronto.
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QR!Codes

R “Quick Response” codes are
fast becoming a popular
means of communicating snippets

of information from a printed
medium or other physical surface
towards computers and mobile
devices. They were originally
developed as a replacement for

the single-dimension bar code by a

team from the automotive
equipment design and
manufacturing company Nippon

Denso Co. Ltd.. The increase in the
: get up-to-date information on

. scheduling, a poster for a music

. festival with a QR-enabled link to
. the online ticketing service, or

. train or aircraft tickets with QR

. codes that are read at the entrance :
. stile to enable access to boarding.

amount of different car parts
handled gave rise to a desire to
augment correspondingly the
amount of data that could be
stored on the printed labels that
were used to identify the boxes in
storage and during transport.

Since 2006, the working

principles have become the ISO/IEC :
. use of the fact that data is actually :

- redundant inside the code; the

. image can be modified in various
- ways and still convey useful

. information to the reader. A recent :
. example from 2014 is the

© “Guinness QR cup” by BBDO New
- York that has won a Caples award

standard 18004:2006, and so can
be seen as a recognized industry
technique. The team behind this
design (Masahiro Hara, Motoaki
Watabe, Tadao Nojiri, Takayuki
Nagaya, and Yuji Uchiyama ) won
the European Patent Office 2014
Popular Prize for their efforts
(http://www.epo.org/learning-

events/european- :
. inventor/finalists/2014/hara.html). :

link to the company’s web page to

At the same time, the folks in
graphics design have been making

(http://www.caples.org/quinness-

: gr-cup-0). The idea refers to a :
Guinness beer glass with a printed
: QR code, that is readable only :
. Nowadays, QR codes are widely :
: used in situations in which it is

. desirable to present printed

© matter containing links to

. electronic information, in a way
that is easy for a computer to read
. in. Examples include applications
: such as a bus-stop transportation
. map that includes a QR-encoded

when the glass is still full of the

- black stuff: only the white dots are :
: actually printed, while the black
. dots are the beer itself showing
. through from behind.

In this article, we will see how

. to read and create QR codes in an
: Ubuntu system using various

. programs. Before continuing, it

- should be noted that several other : ) : ,
- similar systems can be found, such : matrix of dots (pixels), that, in
: as Data Matrix barcodes
. (https://en.wikipedia.org/wiki/Dat :
© a_Matrix) and Aztec codes

https: .wikipedia. iki/Azte :
(httos://en.wikipedia.ora/wiki/Az ei get intimate with binary code since

. itis often obscured by the various
. layers of software in between.

. ¢_Code). Though each of these

. systems is popular in places, QR

. codes seem, for the time being, to
. be the best supported, both by

Ubuntu and applications o ob'leg
unhtiand applications on mobi . placed before this image, the first

. parts that are detected are the

. three positioning marks

. emphasised in gold. These give the
. camera a basic idea of the position
. of the the QR code, as well as its

. orientation. The small mark in red

* also helps understand alignment;

. devices.

. THE ANATOMY OF A
QR CODE

Let us consider a specific

: example:
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As can be seen, a QR code is in

. fact a two-dimensional square

. essence, are binary zeros and ones.
: This is in fact about the only time a
: modern user of computing

. equipment will have the chance to

When a QR code readeris
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SECURITY

there is only one of these on small
QR codes, but larger codes use a
repeating pattern to ensure
coherence across the width and
height of the image.

QR codes may be of varying
widths, expressed in the number
of dots used. However, this has
nothing to do with the actual
physical size of the image, nor to
the resolution of the photograph
the reader has taken of it. So the
second stage in code
interpretation is to figure out how
many dots are being used in this

particular code. To do this, a simple

repeating pattern of black and
white dots is placed between the
orientation marks (shown in
green). This “timing” pattern is
easy for the reader to interpret,
and so figure out the number of
lines and columns in the mesh.

to a mix of QR code version
information, format information,
the actual data, and error
correction codes. Error correction
is necessary, since cameras do not
always give a clear image of the
code area (due to the presence of
dust, scratches on the lens, etc.),
interpretation may also get some
dots wrong (if colors are not

correctly detected), and motion
blur if the camera is not held

. perfectly still at the time,

Error correction in QR codes

: uses a branch of Reed-Solomon

. error-correcting codes. With a bit

. of (perhaps over-) simplification,

. these codes can be seen as

- basically repeating all information
. more than once. Redundancy is

- calculated in such a way that not

. only can errors be detected, but

- also corrected upon reading. With
. sufficient extra bits added to each
- data word, more than one single
error can be detected - unlike more :
- simple schemes in which two :
. errors in the same word could go
- undetected.

Nowadays, the details of how

. the error detection and correction
- are handled go quite under the

: radar of the human user. Software
The rest of the dots correspond :
. or hardware (in industrial

. applications) take care of this part
. and simply give us the decoded

- information in readable form.

(on most consumer-grade devices)

In fact, the addition of

superimposed colors to the QR
code above has not made it
" unreadable - if you have a QR

reader or application available, go

ahead and see what it says!

. SOME SOFTWARE

There is in fact a selection of

. software available in the Ubuntu

. repositories to create QR codes.

. One of the most basic is grencode
. from the apt package with the

. same name. This is a console-only
. program. For example, to encode

. the web page address of our

: favorite magazine, simply issue:

; grencode -o gr—examplel.png :
: http://fullcirclemagazine.org :
. perhaps the best known

application for Ubuntu is QtQr.

: Using the Qt library on which the
KDE desktop is based, this

: program also works quite well
under other desktop managers,

. being sufficiently integrated to
include dragging files to and fro.

This creates the image gr-

example1.pngin the current
. directory:

The same program can also

. create QR codes in a variety of
. formats. One of particular interest :
: is SVG. The corresponding
. command would be:

E grencode -o gr—examplel.svg
: -t SVG :
" http://fullcirclemagazine.orgqg :

Full circle magazine #103 @ 53

In the other direction, the zbar-
tools package contains programs

to handle converting a QR code

: read in from the camera (zbarcam)
or from an image file (zbarimg).

. Forinstance:

E zbarimg gr—-examplel.png

. OR-
: Code:http://fullcirclemagazin
: e.org/

; scanned 1 barcode symbols
: from 1 images in 0.02 seconds

On the graphical side of things,

The software contains a

complete QR code generator,

. where the user can not only

. specify the type of information to
: be encoded (URLs, but also other
. structured information such as

. personal contact information,

. georeference or even WiFi

. network details), but also the dot
. size in pixels, margin width and

level of data redundancy to be

n contents ©
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QtQR: QR Code Generator

Select data type:

LURL -

URL to be encoded:

http://fullcirclemagazine.org

Parameters:
Pixel Size:  Error Correction:  Margin Size:
3 m Lowest - 4 -

ClErdl)

used.

QtQrreads in QR codes either
from image files, or by accessing
the computer’s webcam if
available. This is handy to read in
data from a mobile phone, without
needing to set up wireless
communication (Bluetooth or
similar).

EDITING QR CODES

Once a QR code has been
created, some editing can take
place without altering the
information contained within. To
take an example, | will take the
“http://Fullcirclemagazine.org” QR
above, in SVG form. As line-art, it
can then be imported into a vector

. editing program such as Inkscape
. and modified to suit our needs.

. Opening it with Inkscape, the first
. thing we notice is that the white

- background has been grouped

. together with the black markings.
. We can select the complete

- assembly and hit Ctrl-Shift-G to

: ungroup them.

The black markings themselves

. are also individual rectangles that
. have been grouped together. If we . end-points to make sure that both
- wish to alter individual pieces, they :
- will also need to be ungrouped

. first. For our examples, however,

. we will keep them together in one

. piece.

The first thing we can do with

. the black markings is to change

their color. Select the markings,

then choose Object > Fill and
Stroke in the menu. We can play

- around with the fill color, and add
blur for artistic effect.

g»r«l.a

@p-.

of the colors used to build the
. gradient are sufficiently

ﬁl

<)

0.

e

)
R
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contrasted with the background.
Some experimentation may be

. needed for good results.

In Inkscape, photographs may

. be used as patterns to fill in areas.
The image (JPG, PNG or similar) is

. imported, then converted into a
pattern using menu option Object
: > Pattern > Objects to Pattern. The
black markings in the QR code are

: QR codes are sufficiently robust :
: that even relatively light colors can
: be used, and still function as a

. code. However, one should not try :
: to go too far - ‘too far’ being colors :
- with little contrast to the

. background, or a combination of
. light and dark colors. These do not
. work well with most QR readers. If :
: we do stay within these :
. parameters, some effects such as
. gradients are possible. To apply

. these, select the markings, and in
. the Fill dialog choose Gradient fill.
© You will need to edit the gradient

then selected, and filled with the
new pattern. As before, it is best to

. use images with similar and rather
: dark colors - and no very light-

colored spots in them (if using a

. white background).

EI'E"E

|l1

Ells-.""':'.'E

On the other hand, very light

images can be used to color the

. markings, on top of a dark

. background. Alternatively, a single
. color can be used for the markings,
. which are then placed on top of

. theimage. As long as there is

. enough contrast for the QR reader
. to detect the markings correctly,

. just about any combination can be
: tried out.
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This is about as far as one can
go with this low-redundancy level
QR code. However, if a high level
of redundancy has been specified
when creating the code, large
areas of dots can be covered up
with other graphical information.

Although this will give some errors :
: Volume 1 :
. (http://fullcirclemagazine.org/inksc :
. ape-special-edition-volume-one/), :
- specifically Part 5 for details on

- how to fill regions.

on reading, the error-correction
codes used will still enable the
reader to establish the original
message. There are some areas of
the code that must not be
touched. As described in the
previous section, positioning,
alignment and timing marks are
necessary for good operation.

Altering version information is
probably not a good idea either.
But if we stick to the central part

of the code, we can take some
liberties without going too much

. into the danger zone:

: For further ideas on how to use
. Inkscape, Mark Crutch’'s ongoing

. series in FCM is probably the place o 1 narie I
: tio in Catilinam Prima in Senatu Habi :

to start - try the Special Edition

COLOPHON

acquiring the link without any

human error. They always carry the
darn things around with them, so

- we might as well make good use of :
- them, right?

1st Catilinarian:

L,
s
i

'l.%' N I-::r_'-.r—

A second use of QR codes is to

pass along short quotations from
. texts. QR codes are well able to

| would like to end with a couple hold several paragraphs of text,

- of practical use-cases that go a bit
. further than adding dynamic

: content to commercial posters. In
. my day job as a teacher, | often

. give students pointers on where to :
. obtain further information, if
: necessary, on the topic being :
. studied. For some time now, | have :
. been projecting slides with the
relevant URLs. However, even

. when using shortened URLs (“tiny” :
. URLs), copying mistakes are made
- all too often. Including the relevant :
. URLs in QR form makes it possible
. for students to come up to the

. screen and “shoot” the codes with
. their mobile phones - thus

- about what would be useful for a
- single study period. So, for

. example, Cicero's classical :
- discourse against Catalina could be
- studied in extract form. The :
. original text goes:

“Quo usque tandem abutere,

. Catilina, patientia nostra? Quam diu :
. etiam furor iste tuus nos eludet? :
. Quem ad finem sese effrenata

. jactabit audacia? Nihilne te

nocturnum praesidium Palati, nihil

. urbis vigiliae, nihil timor populi, nihil :
. concursus bonorum omnium, nihil
- hic munitissimus habendi senatus

- locus, nihil horum ora voltusque

* moverunt? Patere tua consilia non

sentis, constrictam iam horum
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omnium scientia teneri
coniurationem tuam non vides? Quid
proxima, quid superiore nocte egeris,

. ubi fueris, quos convocaveris, quid
. consilii ceperis, quem nostrum

. ignorare arbitraris? O tempora, o

. mores!

Transformed into a slide for

. presentation to the class, once

: scanned, the QR code would then
. appear as shown (on the student’s
: tablet):

: The text can then be sent off to
: Google Drive or a note-taking

. application, and -one hopes- also
be worked on.

As a side note, we can see

through this example that QR
. codes are system-agnostic, and

thus a good way of passing

. information between operating

. systems - even though some of

: them may be rather less open than
: Ubuntu.
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LINUX'EOOPBACK

Written by S. J. Webb

As the 1960's developed, Bell
Labs grew. Ali Javan developed
and operated the Ffirst gas laser.
Metal oxide semiconductor and
integrated circuits laid the
groundwork for our current info
society. Soon a carbon laser was
developed. Unix was born in 1969.
Aaron March was the first graphic
designer to create a barebone GUI
for computer systems.

These quick changes led to the
1970s’. Dennis Ritchie (above)
compiled the C computer language

: which was used to rewrite part of
: Unix. Fiber Optic cables were

. developed and tested in Atlanta,
© Georgia. The first 32 bit

: microprocessor was developed.

. Numerous other telephony devices :
: were created. Bell Labs

: undoubtedly was a mecca of

: technology genius in this time
: frame.

in 1984. The U.S. federal
: government broke up ATT due to

: This lead to Western Electric

. becoming the sole owner of Bell
Labs. Western Electric was now

. called ATT Tech.

OS meant to replace Unix in 1985.
: Later on the Inferno OS was
However this time frame ended developed to refine Plan 9. There

Preparing menu. ..

The following tasks are done:
canfigfs - choose the type of file system to install _
partdisk edit partition tables (e.g., to create a plan 9 partition)
prepdi sk - subdivide plan 9 disk partition
FrmtFossil — dpdeiald TS E il coas
mountfs - chod Installing file system i
configdist - | | B
mountdist — T L Ty

The following unfinished tasks are ready to be done:
copydist - copy the distribution into the file system W

Task to do [copwdist]:

!

not prompt: fsws main create Jfactivefdist/replica sys sys d775

;{m prompt: fsys main create Sfactivefdist/replicafclient sys sys d| :
775
prompt: fsys main create Sfactive/dist/replicasclient/pland.db
sys sys BE4 :
prompt: fsys main create Sactive/dist/replicasclient/plang.log| :
SYS 5ys5 abE4

prompt: % 9660srv
% mount Ssrv/ 9660 fnSdistmedia fdev/sdD0/data
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: was slow but steady growth in

. developing new technology. In
© its sheer monopoly on phone lines. :
© Lucent Technology. Under the new
© name the first organic laser was

: developed and plastic transistors.

© In 2006 Lucent Technology and

© Alcatel merged under the name of
Plan 9 (shown below) was a new

1996 ATT Tech changed its name to

Bell Labs.

This merger led to downsizing.

© The research center will only begin
© to start focus on profit centers.

: Therefore in 2008 emphasis was

: given to network development,

: high speed electronics, nanotech,

: and software. The lab lost its sense
: of direction due to goals of profit.

© In 2013 the lab realigned itself to

© its earlier roots of information and
. communication technology.

In April of 2015 Nokia bought

: the parent company of Bell Labs,

: and by default Nokia acquired the
: sleeping giant of technology.

: Hopefully Nokia will help lead Bell
© Labs down the path of awe again.
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Written by Oscar Rivera

Shadow Of'Mordor

O ne game to rule them all!
Tolkien's Middle Earth is a
vast insatiable world of fantasy
and adventure. Most people today
are familiar with The Hobbit and
the Lord of the Rings trilogy, but,
somewhere in between, there is a
new adventure that has recently
been released as a video game.
Best described as a single-player,
third-person, open-world, action-
adventure RPG, Middle Earth:
Shadow of Mordor takes place in
the time period after Tolkien's The :
Hobbit, but before The Lord of the :
Rings trilogy. :

In September 2014, Middle
Earth: Shadow of Mordor was first
released for PC, PS4 & Xbox One.
Subsequently, it was also released
for PS3 & Xbox 360 later that year.
Most recently, in July 2015,
Shadow of Mordor was released
for Linux. Immediately following its :
Linux release, word began to :
spread around the Linux
community that this game was a
must-have. Shadow of Mordor
began to appearin just about :
every list of top-ten must-have new
releases with many publications &

: websites nominating and/or
- electing it as Game of the Year. The :
: list of accolades includes GDC :
. Game of the Year, Gamespot's
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. reviews, | couldn't help but buy it
: s0 | could decide for myself

: . whether this game was worth
: Game of the Year, and gamesradar :

: Game of the Year — to name just a
: few. Gaming on Linux claimed that :
- it was a “rare (Linux)... high-quality :
. open-world game... which had
. delivered something special.”

. everything critics claimed it was. |

. was not the least bit disappointed. : ,
. game is.

® 5

After reading so many rave

Developed by Monolith

- Productions, published by Warner
Brothers Interactive
Entertainment, and ported to

. Linux by Feral Interactive, Middle
. Earth: Shadow of Mordor gets my
- vote for Linux Game of the Year. It
- was rather difficult for me to put
. the game down in order to write

this review; that's how good the

To play the game, you can

download it from Steam or Humble
. Bundle for the current regular

. price of $49.99 unless you happen

: to catch a sale anytime in the near
. Future which is not out of the

. question. Once installed, you're

. ready to play. Shadow of Mordor

. has been described as a cross

. between the Assassin's Creed and

W . the Arkham Batman series of

games. Having previously played

- games from both of those series, |
: can testify that such claims are

: accurate. Anyone who has played
. any of the Assassin's Creed or

. Arkham Batman games will feel

. right at home playing Shadow of

. Mordor. However, Middle Earth:

. Shadow of Mordor goes above &

. beyond anything else ever

. developed as it has been injected &
- infused with enough creativity &

innovation to stand on its own as a
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uniquely phenomenal game that
no gamer should do without.

As the game begins, Talion (the
main character), witnesses his
family being murdered by cold-
blooded Orc warriors fighting for
the Black Hand of Sauron. As the

himself is murdered by these
savage Orcs but his soul is unable

he is savagely murdered, Talion
somehow merges with an EIF
Wraith who is also out for revenge
against the Black Hand of Sauron.
Having been magically united,
Talion and the Wraith embark on a
dark journey that will take them
through Mordor as they kill Orcs,

Uruks, chiefs, captains and all sorts

of beasts, animals & monsters on
their quest to exterminate the
Black Hand of Sauron and anyone
who gets in their way. Along the
way, Talion also co-operates with
other characters such as Ratbag,

the Uruk who Talion helps become

war-chief, and we even work
alongside Gollum who is dying to
obtain his “precious ring.”

Talion can engage in melee,
ranged & stealth combat at the
outset of the game. As the story
unfolds, Talion acquires other

combat skills that enhance his
three primary fighting styles via

. the use of runes and learned

. abilities. When you kill enemies,

. especially chiefs & captains, Talion
. earns points and runes, but it is up :
. to you to decide which abilities will :
. be mastered - which is what gives
opening sequence plays out, Talion :

the game its RPG element. There

—which are both upgradeable

. depending on your playing style.
. You control Talion either through
. mouse/keyboard or a game

. controller, both of which work very :

well on this game; the choice is
yours. What really sets this game

apart from anything that has ever
. gone before, is what's been

. referred to as the Nemesis system. :
: Basically, when an opposing enemy :

kills you in this game, not only do

you die and have to re-spawn at a
. predetermined forge tower, but

. are two sides to Talion, the reqular
. human side and the wraith-like side :
to join his Family in the afterlife. As :

the character who killed you, and
any other allies who might have

been with him when you died, will
. level up (ie, increase their level
. number) and use your death to
. their advantage. The way in which

the developers incorporated this
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concept into the game is truly

~ fascinating. The Nemesis system is
- dynamically creating a living
. Mordor which breathes and

pulsates according to your actions
- thus presenting you a soon-to-be

- wasteland tailor made for you.... by
. you.

For example, there was a

: captain in the first half of the game
. who | couldn't defeat — no matter
. how hard I tried. When | first
. encountered him, he was a level 13
: at a time when | was just getting
. comfortable at fighting against
. level 8 enemies. With each death |
. suffered against him, not only
- would he level up, but also his
. strengths would increase while his
. weaknesses decreased. Eventually,
. he was so powerful (lvl 18) that |
. opted to avoid him at all cost until |
. felt | was powerful enough to bring
- him to his knees. When I finally
. chopped off his head, he had risen
. to level 20 and just before my
i sword sliced through his neck he
l : even said something like “at long

- last you've defeated me.” | couldn't
- help but laugh at his comment and
- marvel with a dropped jaw at how
: this particular captain who | had
. helped turn into an unbeatable
- foe, even remembered my playing

style and how many times he'd
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killed me, among other things. If |
call the Nemesis system genius, I'm
still short of giving it the credit it
deserves. | wouldn't doubt to find
influences of the Nemesis system
in future games still to come.

On my system, Shadow of
Mordor had very few glitches, if
any at all. A couple of times | had
to re-start the game with lower

default settings, but I'll be the First :
. I've seriously been thinking about
much bugs, but rather me trying to :
. and cannot come up with anything
. | dislike about it. Although I'm not
. affected by it, | must unfortunately :
. report that Intel & AMD graphics
. are not yet supported, but |

- understand that the game should

to admit that these were not so

push my system beyond its limits.
The game isn't to blame. The
graphics on the game are not next
generation but the fluidity with
which the visuals move in & out of
battle, especially during combat-
finishing moves, are very pleasing
to the eye. The voice acting is
anotherin a long list of strengths.

Shadow of Mordor also comes with

a benchmark which you can run to
test your system. If you are

interested in taking screenshots of

the game, there's even a feature
that can be enabled/disabled

which can potentially turn you into

a real visionary screenshot
publishing artist.

If enabled, the game can be
paused at will and a wide array of
tools appear before you to alter

the paused screenshot and turn it
into a visual masterpiece. You can

. completely change the angle, add a :
. border, focus in/out of it, get up
. close or far back, change the

. “canvas” as it were, make it black & :
. white, sepia, etc. It's a feature |
: found quite useful.

Rather than continue talking

any negative aspects of the game
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still work Fairly well on very low
settings. It would be a shame if
support for AMD & Intel didn't

. come soon. | had to contact Feral
. Interactive regarding compatibility

problems | had while playing this

. game with Valve's new Steam
. Controller, and they promptly :
. replied and gave me some valuable :
: : advice.
. about all of the things I've enjoyed
about this game, it's best | say that :
© superb job in bringing this title to

GHz

. Memory: 4 GB RAM

. Graphics: 1GB NVIDIA 640 or

. better with driver version 352.21

Feral Interactive has done a

way to thank them other than

. buying Shadow of Mordor. | give

the game a solid rating and

. strongly recommend it to

everyone.... or rather to all Mature :
. Audiences who are age 18+ since

that's the game's well deserved
rating as it is rather graphically

 violent.

. MINIMUM REQUIREMENTS:

. 0S: Ubuntu 14.04.2 64-bit /
. SteamOS
. Processor: Intel Core i5-750, 2.67

. or later

. Network: Broadband Internet

. connection

' Hard Drive: 47 GB available space
. Additional Notes: AMD and Intel
. cards are NOT supported.

P

=

Oscar graduated from CSUN, is a
Music Director/Teacher, beta tester,
Wikipedia editor, and Ubuntu
Forums contributor. You can contact
him via: www.gplus.to/7bluehand or
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CHA CHA CHA CHANGES

Our admin went AWOL for months, and
I had no idea if/when the site
would/wouldn’t get paid. Initially the
plan was to move the site and domain
name to my hosting, but eventually |
managed to track him down and get
the FCM domain name, and site hosting
transferred to me.

The new site is now up. HUGE thanks to
Lucas Westermann (Mr. Command &
Conquer) for taking on the job of
completely rebuilding the site, and
scripts, from scratch, in his own time.

The Patreon page that I've set up is to
help me pay the domain and hosting
fees. The yearly target was quickly
reached thanks to those listed on this
page. FCM is not going away. Don’t
worry about that.

Several people have asked for a PayPal
(single donation) option, so I've added
a button to the side of the site

A big thank you to all those who've
used Patreon and the PayPal button.
It's a big help.

https://www.patreon.com/
fullcirclemagazine
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FULL CIRCLE NEEDS YOU! Deadline: admin@fullcirclemagazine.org
A magazine isn't a magazine without articles and Full Circle is no Sunday 05th Dec. 2015.
exception. We need your opinions, desktops, stories, how-to's, Release:
reviews, and anything else you want to tell your fellow *buntu users. Friday 25th Dec. 2015. . ]
Send your articles to: articles@fullcirclemagazine.org E‘,’"t'“g & Proofreading
Mike Kennedy, Gord Campbell, Robert
We are always looking for new articles to include in Full Circle. For help and advice Orsino, Josh Hertel, Bert Jerred, Jim
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Desktop screens should be emailed to: misc@fullcirclemagazine.org
... Or you can visit our site via: fullcirclemagazine.org

Getting Full Circle Magazine:

the epub file, you can drop an email to: mobile@fullcirclemagazine.org

L.J EPUB Format - Recent editions of Full Circle have a link to the epub file on the downloads page. If you have any problems with

@ Issuu - You can read Full Circle online via Issuu: http://issuu.com/fullcirclemagazine. Please share and rate FCM as it helps to
spread the word about FCM and Ubuntu Linux.

Google Play - You can now read Full Circle on Google Play/Books. Either search for 'full circle magazine' or
> click this link: https://play.google.com/store/books/author?id=Ronnie+Tucker

Full circle magazine #103 @ 61 P contents ~


mailto:ronnie@fullcirclemagazine.org
mailto:admin@fullcirclemagazine.org
mailto:articles@fullcirclemagazine.org
http://url.fullcirclemagazine.org/75d471
http://ubuntuforums.org/forumdisplay.php?f=270
mailto:letters@fullcirclemagazine.org
mailto:reviews@fullcirclemagazine.org
mailto:questions@fullcirclemagazine.org
mailto:misc@fullcirclemagazine.org
mailto:mobile@fullcirclemagazine.org
https://apps.ubuntu.com/cat/
http://issuu.com/fullcirclemagazine
mailto:mobile@fullcirclemagazine.org
http://issuu.com/fullcirclemagazine
https://play.google.com/store/books/author?id=Ronnie+Tucker



